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COMPUTER FUNDAMENTALS

Computer:

Computer is an electronic device that is designed to work with Information. The term
computer is derived from the Latin term ‘compute’, this means to calculate. Computer
cannot do anything without a Program. It represents the decimal numbers through a
string of binary digits. The Word 'Computer' usually refers to the Center Processor Unit
plus Internal memory.

CHARLESBABBAGE

Charles Babbage was an English polymath. He was a mathematician, philosopher,
inventor and mechanical engineer, who is best remembered now for originating the
concept of a programmable computer.

Considered a "father of the computer", Babbage is credited with inventing the first
mechanical computer that eventually led to more complex designs. His varied work in
otherfieldshasledhimtobedescribedas"pre-eminent"amongthemanypolymathsof his
century.

FUNCTIONALITESOF COMPUTER:

Anydigitalcomputercarriesoutfivefunctionsingrossterms:

 Takesdataasinput.

 Storesthedata/instructionsinitsmemoryandcanusethemwhenrequired.

 Processthedataandconvertitintousefulinformation.

 Outputtheinformation.

 Controlalltheabovefoursteps.

Definition

ComputerSystemis anelectronicdataprocessingdevice whichdoes thefollowing:

 Acceptandstoreaninputdata.

 Processthedatainput.
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 Andoutputtheprocesseddatainrequiredformat.

ADVANTAGESOFCOMPUTER:

FollowinglistdemonstratestheadvantagesofComputers:
High Speed

 Computerisaveryfastdevice.

 Itiscapableofperformingadditionofverybigdata.

 The computerhasunits of speed inmicrosecond,nanosecond andeven the
picoseconds.

 Itcanperformmillionsofcalculationsinafewsecondsascomparedtomanwho can
spend many months for doing the same task.

Accuracy

 Inadditiontobeingveryfast,computerisveryaccurate.

 Thecomputercanperformcalculations100%errorfree.

 Computersperformalljobswith100%accuracy.

StorageCapability

 Memoryisaveryimportantcharacteristicofacomputer.

 Thecomputerhasmuchmorestoragecapacitythanhumanbeings.

 Itcanstorelargeamountofdata.

 Itcanstoreanytypeofdatasuchasimages,videos,text,audioandanyother type.

Diligence

 Unlikehumanbeings,acomputerisfreefrommonotony,tirednessandlackof
concentration.

 Itcanworkcontinuouslywithoutcreatinganyerrorandboredom.

 Itcandorepeatedworkwithsamespeedandaccuracy.

Versatility

 Acomputerisaveryversatilemachine.



 Acomputerisveryflexibleinperformingthejobstobedone.

 Thismachinecanbeusedtosolvetheproblemsrelatingtovariousdifferent fields.

 Atoneinstant,itmaybesolvingacomplexscientificproblemandtheverynext moment
it may be playing a card game.
Reliability

 Acomputerisareliablemachine.

 Modernelectroniccomponentshavefailurefreelonglives.

 Computersare designedto makemaintenanceeasy.

Automation

 Computerisanautomaticmachine.

 Automationmeansabilitytoperformthetaskautomatically.

 Once a program is given to computer i.e stored in computer memory, the
programandinstructioncancontroltheprogramexecutionwithouthumaninteraction.

ReductionInPaperWork

 Theuseofcomputersfordataprocessinginanorganizationleadstoreductionin paper
work and speeds up the process.

 Asdatainelectronicfilescanberetrievedasandwhenrequired,theproblemof
maintenance of large number of files gets reduced.

Reduction In Cost

 Thoughtheinitialinvestmentforinstallingacomputerishighbutitsubstantially
reduces the cost of each of its transaction.

DISADVANTAGESOFCOMPUTER:

FollowinglistdemonstratesthedisadvantagesofComputersintoday'sarena.

 Acomputerisamachineandhasnointelligenceofitsowntoperformanytask.

 Eachandeveryinstructionhastobegiventothecomputer.

 Acomputercannottakeanydecisiononitsown.



Dependency

 Itcanperformfunctionasinstructedbytheuser,soitisfullydependenton human
being.

Environment

 Theoperatingenvironmentofcomputershouldbedustfreeandsuitabletoit.
NoFeeling

 Computerhasnofeelingoremotions.

 ItcannotmakeJudgmentbasedonfeelings,tastes,experiencesandknowledge unlike
a human being.

APPLICATIONSOFCOMPUTER

Banking

TodayBankingisalmosttotallydependentoncomputer. Banks

provide following facilities:

 Bankson-lineaccountingfacility, whichincludecurrentbalances,deposits,
overdrafts, interest charges, shares and trustee records.

 ATMmachinesaremakingiteveneasierforcustomerstodealwithbanks.

Insurance

Insurance companies are keeping all records up to date with the help of computer.The
Insurance Companies, Finance houses and Stock broking firms are widely using
computers for their concerns.

InsuranceCompaniesaremaintainingadatabaseofallclientswithinformationshowing

 howtocontinuewithpolicies

 startingdateofthepolicies

 nextdueinstallmentofapolicy

 maturity date

 interestsdue

 survivalbenefits

 bonus



Education

ThecomputerhasprovidedalotoffacilitiesintheEducationSystem.

 The uses of computer provide a tool in the Education system is known as CBE
(Computer Based Education).

 CBEinvolvesControl,DeliveryandEvaluationoflearning.

 The computer education is very familiar and rapidly increasing the graph of
computer students.

 Therearenumberofmethodsinwhicheducationalinstitutionscanusecomputer to
educate the students.

 It is used for prepare a database about student performance and analysis are
carried out.

Marketing

InMarketingusesofcomputerarefollowing:
 Advertising: With computers, advertising professionals create art and graphics,

write and revise copy and print and disseminate ads with the goal of selling more
products.

 At Home Shopping: At home shopping has been made possible through use of
computerized catalogues that provide access to product information and permit direct
entry of orders to be filled by the customers.

HealthCare

ComputershavebecomeimportantpartinallMedicalSystems.

The computers are being used in hospitals to keep the record of patients andmedicines.
It is also used in scanning and diagnosing different diseases. ECG, EEG, Ultrasounds
and CT Scans etc. are also done by computerized machines.

Someofmajorfieldsofhealthcareinwhichcomputerareused:
 Diagnostic System: Computersareusedtocollectdataandidentifycauseof

illness.
 Lab-diagnostic System: Alltestscanbedoneandreportsarepreparedby

computer.
 Patient Monitoring System: Theseareusedtocheckpatient'ssignsfor

abnormality such as in Cardiac Arrest, ECG etc.
 Pharma Information System: Computer checks Drug-Labels, Expiry dates,

harmful drug side effects etc.

 Nowadays,computersarealsousedinperformingsurgery.



Engineering Design

Computersarewidelyusedinengineeringpurposes.

One of major areas is CAD (Computer Aided Design). CAD provides creation, edition
and modification of image. Some fields are:

 Structural Engineering: Requires stressandstrain analysis requiredfor design of
Ships, Buildings, Budgets, and Airplanes etc.

 Industrial Engineering: Computersdealswithdesign,implementationand
improvement of integrated systems of people, materials and equipments.

 Architectural Engineering: Computers help in planning towns, designing
buildings,determiningarangeofbuildingsonasiteusingboth2Dand3Ddrawings.

Military
Computers are largely used in defense. Modern tanks, missiles, weapons etc. employ
computerized control systems. Some military areas where a computer has been used
are:

 MissileControl

 MilitaryCommunication

 Militaryoperationandplanning

 SmartWeapons

Communication

Communication means to convey a message, an idea, a picture or speech that is
receivedandunderstoodclearlyandcorrectlybythepersonforwhomitismeant.Some main
areas in this category are:

 E-mail

 Chatting

 Usenet

 FTP

 Telnet

 Video-conferencing

Governmentapplications

Computers play an important role in government applications. Some major fields in this
category are:

 Budgets

 Salestaxdepartment



 Incometaxdepartment

 Male/Femaleratio

 Computerizationofvoterslists

 ComputerizationofDrivingLicensingsystem

 ComputerizationofPANcard

 WeatherForecasting.

TYPESOFCOMPUTER:

Computercanbebroadlyclassifiedbytheirspeedandcomputingpower.

Sr.
No. Type Specifications

1 PC(PersonalComputer) Single user computer system. Moderately
powerful microprocessor.

2 WorkStation
Single user computer system. Similar to
Personal Computer but have more powerful
microprocessor.

3 MiniComputer
Multi-user computer system. Capable of
supporting hundreds of userssimultaneously.

4 MainFrame

Multi-user computer system. Capable of
supporting hundreds of userssimultaneously.
Software technology is different from
minicomputer.

5 Supercomputer
An extremely fast computer which can
perform hundreds of millions of instructions
per second.

INPUTDEVICES

FollowingarefewoftheimportantinputdeviceswhichareusedinComputerSystems

 Keyboard

 Mouse

 JoyStick

 Lightpen



 TrackBall

 Scanner

 GraphicTablet

 Microphone

 MagneticInkCardReader(MICR)

 OpticalCharacterReader(OCR)

 BarCodeReader

 OpticalMarkReader

OUTPUT DEVICES

FollowingarefewoftheimportantoutputdeviceswhichareusedinComputerSystems

 Monitors

 GraphicPlotter

 Printer

CPU(CENTRALPROCESSING UNIT)

 CPUisconsideredasthebrainofthecomputer.

 CPUperformsalltypesofdataprocessingoperations.

 Itstoresdata,intermediateresultsandinstructions(program).

 Itcontrolstheoperationofallpartsofcomputer.

CPU itself hasfollowing threecomponents.

 MemoryOrStorageUnit:

 ControlUnit

 ALU(ArithmeticLogicUnit)



Memoryor Storage Unit:
This unit can store instruction, data and intermediate results. This unit supplies
informationtotheotherunitsofthecomputerwhenneeded.Itisalsoknownasinternal storage
unit or main memory or primary storage or Random access memory (RAM).

Its size affects speed, power and capability. There are primary memory and secondary
memory two types of memories in the computer.

FunctionofMemoryUnitis:

Itstoresallthedatatobeprocessedandtheinstructionsrequiredforprocessing. It stores

intermediate results of processing.

Itstoresfinalresultsofprocessingbeforetheseresultsarereleasedtoanoutput device.

Allinputsandoutputsaretransmittedthroughmainmemory.

Control Unit:
Thisunitcontrolstheoperationsofallpartsofcomputer.Itdoesnotcarryoutanyactual data
processing operations.

Functionsofthisunitare

Itisresponsibleforcontrollingthetransferofdataandinstructionsamongotherunitsof a
computer.

Itmanagesandcoordinatesalltheunitsofthecomputer.

Itobtainstheinstructionsfromthememory,interpretsthemanddirectstheoperationof the
computer.

ItcommunicateswithInput/outputdevicesfortransferofdataorresultsfromstorage. It does

not process or store data.

ALU(ArithmeticLogicUnit):

Thisunitconsistsoftwosub-sectionsnamely

 Arithmetic section

 LogicSection



ARITHMETICSECTION
Function of Arithmetic section is to perform arithmetic operations like addition,
subtraction, multiplication and division. All complex operations are done by making
repetitive use of above operations.

LOGIC SECTION
Function of logic section is to perform logic operations such as comparing, selecting,
matching and merging of data.

Unitsof Computer MemoryMeasurements

1Bit=BinaryDigit(BitsofComputerare0and1) 8 Bits
= 1 Byte
1024Bytes=1KB(KiloByte)
1024 KB = 1 MB (Mega Byte)
1024 MB = 1 GB(Giga Byte)

Computer Memory
In computing, memory refers to the physical devices used to store programs
(sequences of instructions) or data (e.g. program state information) on a temporary or
permanent basis for use in a computer or other digitalelectronic device. The term
primary memory is used for the information in physical systems which function at high-
speed (i.e. RAM), as a distinction from secondary memory, which are physical devices
for program and data storage which are slow to access but offer higher memory
capacity. Primary memory stored on secondary memory is called "virtual memory". An
archaic synonym for memory is store.

Theterm"memory",meaning primarymemoryisoften(butnotalways)associatedwith
addressable semiconductor memory, i.e. integrated circuits consisting of silicon-based
transistors, used for example as primary memory but also other purposes in computers
and other digitalelectronic devices. There are two main types of semiconductor memory:
volatile and non-volatile. Examples of non-volatile memory are flash memory
(sometimes used as secondary, sometimes primary computer memory) and
ROM/PROM/EPROM/EEPROM memory (used for firmware such as boot programs).
Examples of volatile memory are primary memory (typically dynamic RAM, DRAM), and
fast CPU cache memory (typically static RAM, SRAM, which is fast but energy-
consuming and offer lower memory capacity per area unit than DRAM) .

Volatile memory

Volatile memory is computer memory that requires power to maintain the stored
information. Most modern semiconductor volatile memory is either Static RAM or
dynamicRAM.SRAMretainsitscontentsaslongasthepowerisconnectedandis easy to
interface to but uses six transistors per bit. Dynamic RAM ismore complicated
tointerfacetoandcontrolandneedsregularrefreshcyclestopreventitscontentsbeing lost.
However, DRAM uses only one transistor and a capacitor per bit, allowing it to reach
much higher densities and, with more bits on a memory chip, be much cheaper per bit.
SRAM is notworthwhile for desktop systemmemory,where DRAM dominates,
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but is used for their cache memories. SRAM is commonplace in small embedded
systems, which might only need tens of kilobytes or less. Forthcoming volatile memory
technologies that hope to replace or compete with SRAM and DRAM include Z-RAM,
TTRAM, A-RAM and ETA RAM.

Non-volatilememory

Non-volatile memory is computer memory that can retain the stored information even
when not powered. Examples of non-volatile memory include read-only memory(ROM),
flashmemory,mosttypesofmagneticcomputerstoragedevices(e.g. harddisks,floppydiscs
and magnetic tape), optical discs, and early computer storage methods such as paper
tape and punched cards.
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OPERATINGSYSTEM
Anoperatingsystemisaprogramthatactsasaninterfacebetweenthesoftwareand the
computer hardware.

 It is an integration set of specialized programs that are used to manage overall
resources and operations of the computer.

 It is specialized software that controls and monitors the execution of all other
programs that reside in the computer, including application programs and other system
software.

ObjectivesofOperating System

 Makingacomputersystemconvenienttouseinanefficientmanner

 Tohidethedetailsofthehardwareresourcesfromtheusers

 Toprovideusersaconvenientinterfacetousethecomputersystem.

 To act as an intermediary between the hardware and its users and making it
easier for the users to access and use other resources.

 Managetheresourcesof acomputersystem.

 Keep track of who is using which resource, granting resource
requests,accordingforresourceusingandmediatingconflictingrequestsfrom different
programs and users.

 Theefficientandfairsharingofresourcesamongusersandprograms

CharacteristicsofOperatingSystem
 Memory Management -- It keeps tracks of primary memory i.e. what part of it

are in use by whom, what part are not in use etc. Allocates the memory when the
process or program requests it.

 Processor Management -- Allocate the processor (CPU) to a process. De-
allocate processor when processor is no longer required.

 Device Management -- Keep tracks of all devices. This is also called I/O
controller. Decides which process gets the device when and for how muchtime.

 FileManagement-- Allocates the resources. De-allocates the resources. Decides
who gets the resources.

 Security -- By means of passwords & similar other techniques, preventing
unauthorized access to programs & data.

 Jobaccounting-- Keeping track of time & resources used by various jobs and/or
users.



 Control over system performance -- Recording delays between request for a
service & from the system.

 Interaction with the operators --Theinteractionmaytakeplaceviatheconsole of
the computer in the form of instructions. Operating System acknowledges the same, do
the corresponding action and inform the operation by a displayscreen.

 Error-detecting aids -- Production of dumps, traces, error messages and other
debugging and error-detecting methods.

 Coordination between other software and users -- Coordination and
assignment of compilers, interpreters, assemblers and other software to the various
users of the computer systems.

WINDOWS7

Windows 7 is an operating system produced by Microsoft for use on personal
computers, including home and business desktops, laptops, net books, tablet PCs, and
media center PCs. It was released to manufacturing on July 22, 2009, and became
generallyavailableretailworldwideonOctober22,2009,lessthanthreeyearsafterthe release
of its predecessor, Windows Vista. Windows 7's server counterpart, WindowsServer
2008 R2, was released at the same time. Windows 7 is succeeded by Windows8.

Unlike Windows Vista's many new features, Windows 7 was an incremental upgrade
designedtoworkwithVista-compatibleapplicationsandhardware.Presentationsgiven
byMicrosoft in2008 focused on multi-touch support, an updatedWindows shell with a
new taskbar, referred to internally as the Superbar, a home networking system called
Home Group, and performance improvements. Some standard applications that have
been included with prior releases of Microsoft Windows, including Windows Calendar,
Windows Mail, Windows Movie Maker, and Windows Photo Gallery, are not included in
Windows 7; most are instead offered separately at no charge as part of the
WindowsEssentials suite.

InstallWindows7

ManypeoplehavecomputersthatcomewithWindows7sotheymayneverhaveto install it.
However, you may need to installWindows 7 if:

 Youreplacedyourharddiskdrivewithanewharddiskdrivethatdoesnothave Windows
7 installed.

 YouarereinstallingWindows7onacomputerbecauseyouwanttocleanoff your
hard drive and remove any unwanted programs, such asspyware.

 Youpurchasedacomputerwithoutanoperatingsystem.
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Pre-installation checklist

Beforeyoubegintheinstallationprocess,usethischecklisttomakesurethatyouare prepared:

 YouhavetheWindows7CD.
 Youhavetheproductkeyavailable.Theproductkeyislocatedonyour

Windows 7 CD case and is required to install and activate Windows 7.
 Your computer hardware is set up. At a minimum, you should connect your

keyboard,mouse,monitor,andCDdrive.Ifavailable,youshouldconnectyour
computer to a wired network.

 You haveWindows 7 drivers available. Drivers are software thatWindows 7 uses
to communicate with your computer’s hardware. If youdo nothave drivers
available, Windows 7 may already include drivers for your hardware. If not, you
should be able to download them from your hardware manufacturer’s website
after you set up Windows 7.

 If you are reinstalling Windows 7 on an existing computer, you need a backup
copyofyourfilesandsettings.Theinstallationprocesswilldeleteallofyourfiles. You can
use the File and SettingsTransferWizard to store yourfilesandsettings on
removable media and then restore them after installation iscomplete.

Installation process

InstallingWindows7cantakeuptotwohours.Tomaketheprocessmoremanageable, it has
been broken up into several sections.

ToBeginInstallation:

1. InserttheWindows7CDintoyourcomputerandrestartyourcomputer.
2. IfpromptedtostartfromtheCD,pressSpacebar.Ifyoumisstheprompt(itonly appears

for a few seconds), restart your computer to tryagain.
3. Windows7Setupbegins.Duringthisportionofsetup,yourmousewillnotwork, so you

must use the keyboard. On the Welcome to Setup page, press Enter.
4. On the Windows 7 Licensing Agreement page, read the licensing agreement.

PressthePageDownkeytoscrolltothebottomoftheagreement.Thenpress F8.
5. This page enables you to select the hard disk drive on which Windows 7 will be

installed. Once you complete this step, all data on your hard disk drive will be
removed and cannot be recovered. It is extremelyimportant that you have a
recent backup copy of your files before continuing. When you have a backup
copy,pressD,andthenpressLwhenprompted.Thisdeletesyourexistingdata.

6. PressEntertoselectunpartitionedspace,which appearsbydefault.
7. Press Enter again to select Formatthepartition usingthe NTFSfilesystem,

which appears by default.
8. Windows 7 erases your hard disk drive using a process called formatting and

thencopiesthesetupfiles.Youcanleaveyourcomputerandreturnin20to30 minutes.



ToContinuethe Installation

1. Windows 7 restarts and then continues with the installation process. From this
pointforward,youcanuseyourmouse.Eventually,theRegionalandLanguage
Options page appears. Click Next to accept the default settings. If you are
multilingual or prefer a language other than English, you can change language
settings after setup is complete.

2. On the Personalize YourSoftwarepage, typeyourname and yourorganization
name. Some programs use this information to automatically fill in your name
when required. Then, click next.

3. On the Your Product Key page, type your product key as it appears on your
Windows7 CDcase.The productkeyisuniqueforeveryWindows7 installation. Then,
click Next.

4. On the Computer Name and Administrator Password page, in the Computer
name box, type a name that uniquelyidentifies your computer in your house,
such as FAMILYROOM or TOMS. You cannot use spaces or punctuation. Ifyou
connect yourcomputerto anetwork,you will use thiscomputername tofind
sharedfilesandprinters.Typeastrongpasswordthatyoucanrememberin the
Administrator password box, and then retype it in the Confirm password box.
Write the password down and store it in a secure place. Click Next.

5. OntheDateandTimeSettingspage,setyourcomputer’sclock.Then,clickthe Time
Zone down arrow, and select your time zone. Click Next.

6. Windows7willspendaboutaminuteconfiguringyourcomputer.Onthe
Networking Settings page, click next.

7. OntheWorkgrouporComputerDomainpage,clickNext.

To complete the installation

1. Windows 7 will spend 20 or 30 minutes configuring your computer and will
automaticallyrestartwhenfinished.WhentheDisplaySettingsdialogappears, click
OK.

2. WhentheMonitorSettingsdialogboxappears,clickOK.
3. Thefinalstageof setupbegins.OntheWelcometoMicrosoftWindows page, click

Next.
4. On the Helpprotect yourPCpage,clickHelpprotectmyPCbyturningon

Automatic Updates now. Then, click Next.
5. Windows7willthencheckifyouareconnectedtotheInternet:

o IfyouareconnectedtotheInternet,selectthechoicethatdescribesyour
networkconnectionontheWillthiscomputerconnect to the Internet
directly,orthroughanetworkpage.Ifyou’renotsure,acceptthedefault
selection, and click Next.

o Ifyouusedial-upInternetaccess,orifWindows7cannotconnecttothe
Internet,youcanconnecttotheInternetaftersetupiscomplete.Onthe How
will this computer connect to the Internet? page, click Skip.

6. Windows 7 Setup displays the Ready to activate Windows page. If you are
connectedtotheInternet, clickYes, and thenclickNext. If youarenot yet
connectedtotheInternet,clickNo,clickNext,andthenskiptostep24.After



setupiscomplete,Windows7willautomaticallyremindyoutoactivateand
register your copy of Windows 7.

7. OntheReadytoregisterwithMicrosoftpage,clickYes,andthenclickNext.
8. OntheCollectingRegistrationInformationpage,completetheform.Then,click Next.
9. OntheWho willusethiscomputerpage,typethenameofeachpersonwhowill usethe

computer.Youcanusefirstnamesonly,nicknames,orfullnames.Then click Next.
10. OntheThankyou!Page,clickFinish.

Windows7setupiscomplete.Youcanlogonbyclickingyournameonthelogon screen. If
you’ve installedWindows7 on anewcomputerornewhard diskdrive, you can now
use the File and Settings Transfer Wizard to copy your important data to your
computer or hard disk drive.

MS-DOS

Shortfor Microsoft Disk operating system, MS-DOS is a non-graphical command line
operating system derived from 86-DOS thatwas created forIBM compatiblecomputers.
MS-DOSoriginallywrittenbyTimPetersonandintroducedbyMicrosoftinAugust 1981 and was
last updated in 1994 when MS-DOS 6.22 was released. Today, MS-
DOSisnolongerused;however,thecommandshell,morecommonlyknownas the Windows
command line is still used by many users.

Today, most computer users are only familiar with how to navigate Microsoft Windows
usingthemouseUnlike Windows,MS-DOSisacommand-lineandisnavigatedby using MS-
DOS commands. For example, if you wanted to see all the files in a folder in Windows
you would double-click the folder to open the folder in Windows Explorer. In MS-DOS,
to view that same folder you would navigate to the folder using the CD command and
then list the files in thatfolder using the dircommand.

DOS Commands

MS-DOS has a relatively small number of commands, and an even smaller number of
commonly used ones. Moreover, these commands are generally inflexible because, in
contrast to Linux and other Unix-like operating systems, they are designed to
accommodate few options or arguments(i.e., values that can be passed to the
commands).

Some of the most common commands are as follows (corresponding commands on
Unix-like operating systems are shown in parenthesis):

CD-changesthecurrentdirectory(cd)
COPY - copies a file (cp)
DEL-deletesa file(rm)
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DIR-listsdirectorycontents(ls)
EDIT-startsaneditortocreateoreditplaintextfiles(vi,vim,ed,Joe) FORMAT -
formats a disk to accept DOS files (mformat)
HELP-displaysinformationaboutacommand(man,info) MKDIR -
creates a new directory (mkdir)
RD-removesadirectory(rmdir)
REN - renames a file (mv)
TYPE-displayscontentsofafileonthescreen(more,cat)

OtherDOSCommand commonlyused are:

Append
Theappendcommandcanbeusedbyprogramstoopenfilesinanotherdirectoryasif they were
located in the current directory.
Attrib
Theattribcommandisusedtochangetheattributesofasinglefileoradirectory.
Break
ThebreakcommandsetsorclearsextendedCTRL+Cchecking.
Call
Thecallcommandisusedtorunascriptorbatchprogramfromwithinanotherscriptor batch
program.
Thecallcommandhasnoeffectoutsideofascriptorbatchfile.Inotherwords,running the call
command at the DOS prompt will do nothing.
Chcp
Thechcp command displaysorconfigures the active codepage number.
Chdir
The chdir command isused to displaythe drive letter and folder that you are currently
in.Chdircanalsobeusedtochangethedriveand/ordirectorythatyouwanttoworkin. Chkdsk
Thechkdskcommand,oftenreferredtoascheck disk,isusedtoidentifyandcorrect certain
hard drive errors.
Choice
Thechoicecommandisusedwithinascriptorbatchprogramtoprovidealistof choices and
return the value of that choice to the program.
Cls
Theclscommandclearsthescreenof allpreviouslyenteredcommandsandothertext.
Dir
Thedircommandisusedtodisplayalistoffilesandfolderscontainedinsidethefolder that you
are currently working in.
Thedircommandalsodisplaysotherimportantinformationliketheharddrive'sserial
number,thetotalnumberoffileslisted,theircombinedsize,thetotalamountoffree space left
on the drive, and more.
DIR[drive:][path][filename][/P][/W][/A[[:]attributes]][/O[[:]sortorder]][/S][/B][/L][/V]

[drive:][path][filename]Specifiesdrive,directory,orfilestolist.(Couldbeenhancedfile
specification or multiple file specs)

/P Pausesaftereachscreenfulofinformation.

http://www.linfo.org/plain_text.html
http://www.linfo.org/vi/index.html
http://www.linfo.org/man.html
http://www.linfo.org/mkdir.html
http://www.linfo.org/rmdir.html
http://www.linfo.org/mv.html
http://www.linfo.org/cat.html
http://www.computerhope.com/jargon/m/multfile.htm


/W Useswidelistformat.
attributes:
DDirectories
RRead-onlyfiles

/A HHiddenfiles
AFilesreadyforarchiving S
System files
-Prefixmeaningnot
Listbyfilesinsortedorder,sortorder: N
By name (alphabetic)
SBysize(smallestfirst)
EByextension(alphabetic)

/O DBydateandtime(earliestfirst)
GGroupdirectoriesfirst
-Prefixtoreverseorder
AByLastAccessDate(earliestfirst)

/S Displaysfilesinspecifieddirectoryandallsubdirectories.



WINDOWSOPERATION
MS- PAINT
Paint is a drawing tool you can use to create simple or elaborate drawings. These
drawings can be either black-and-white or color, and can be saved as bitmap files. You
can print your drawing, use it for your desktop background, or paste it into another
document. You can even use Paint to view and edit scanned photos.

You can also use Paint to work with pictures, such as .jpg, .gif, or .bmp files. You can
paste a Paint picture into another document you've created, or use it as your desktop
background.

Todrawastraightline
1. Inthetoolbox,clickLine .
2. Belowthetoolbox,clickalinewidth.
3. Dragthepointertodrawtheline.

Todraw a freeformline
1. Inthetoolbox,clickLine .
2. Dragthepointertodrawtheline.

Todraw acurvedline
1. Inthetoolbox,clickCurve .
2. Belowthetoolbox,clickalinewidth.
3. Drawastraightlinebydraggingthepointer.
4. Click whereyou wantonearcofthecurvetobe,andthendragthepointertoadjust the curve.

Repeat this step for a second arc. You can only create two curves for each line.

Tosend animageusing e-mail
After you are done working on an image, you can send it to anyone who has an e-mail
account (as long as you also have access to an e-mail account).
1. OntheFilemenu,clickSend.
2. Youre-mailprogramwilldisplay,withyourimageincludedeitherasanattachment or as

part of the message section of your e-mail.
3. Specifyyourrecipient'se-mailaddress, a subject,andamessage;thensend the e- mail

as you normally would.

Todraw arectangleorsquare
1. In the toolbox, click Rectangle to create a square-cornered shape, or

click Rounded Rectangle to create a round-cornered shape.
2. Belowthetoolbox,clickafillstyle.
3. Todrawarectangle,dragthepointerdiagonallyinthedirectionyouwant.
4. Todrawasquare,holddownSHIFTwhiledraggingthepointer.

Toacquireanimagefroma scanneroradigital camera
1. OntheFilemenu,clickFromScanner or Camera.
2. IntheGetPicturesdialogbox,clicktheimageyouwant,andthenclickGetPicture.



NOTEPAD

Notepadoverview
Notepad is a basic text editor you can use for simple documents or for creating Web
pages. The most common use for Notepad is to view or edit text (.txt) files, but many
users find Notepad a simple tool for creating Web pages.
Because Notepad supports only very basic formatting, you cannot accidentally save
special formatting in documents that need to remain pure text. This is especially useful
when creating HTML documents for a Web page because special characters or other
formatting may not appear in your published Web page or may even cause errors.
You can save your Notepad files as Unicode, ANSI, UTF-8, or big-endian Unicode.These
formats provide you greater flexibility when working with documents that use different
character sets.

WORDPAD

WordPad isabasicwordprocessorthatisincludedwith almostallversionsof Microsoft
Windows from Windows 95 onwards. It is more advanced than Notepad but simpler
than Microsoft Works Word Processor and Microsoft Word. It replaced MicrosoftWrite.

UsingWordPad
WordPad is a basic word processor that is included in Windows. A word processor is a
computerprogramthatyoucanusetocreate,edit,view,andprinttextdocuments.With
WordPad,youcantypeletters,bookreports,andothersimpledocuments.Youcanalso change
how the text looks, quickly move sentences and paragraphs around, and copy and
paste text within and between documents.

TheWordPadwindow
ToopenWordPad,clicktheStart button ,clickAll Programs,clickAccessories,and then
click WordPad.

TherearefourmainpartsoftheWordPadwindow:

The toolbar: The toolbar contains buttons for basic commands, including saving and
printing. To find out what a button does, rest your mouse pointer on it. A box pops up
showing the function of the button.

The format bar: Theformatbarcontainsbuttonsthatyoucanusetoformatthetextin
yourdocument.Forexample,youcanchoosethefont,color,andalignmentofyourtext.

Theruler:Usetherulertocheckthelayoutandplacementoftextinyourdocument.

The document area: Thisiswhereyoutypeyourdocument,makechangestothetext, and
apply your formatting.

Typingtext: Whenyou're readyto get started, type in thedocument areaofWordPad.
Aflashingverticallinecalledthecursorindicateswherethenexttextthatyoutypewill
appear.Tomove the cursor within text, click where you want the cursor toappear.



Unlike using a typewriter, when you type in WordPad you don't have to press ENTER to
start a new line. WordPad will take care of that for you by automatically starting a new
line when you reach the end of the one you're working on. When you want to start a
new paragraph, press ENTER.

Selectingtext
Wheneveryouwanttodosomethingtotextinyourdocument,suchascopyitorformat it, you
need to select it first. To select text, position the mouse pointer to the left of where you
want to begin your selection. With the pointer positioned, click and hold the left mouse
button while you drag the pointer over the text that you want to select. The selected
text will be highlighted. Once you've completed your selection, release the mouse
button.

Copyingandmovingtext
If you have text in one part of your document that you want to appear in another part,
there are two ways to move the text around without having to retype it: You can copy
andpaste it to anotherlocation, or you canmove it to another location.

When you copy text, it is placed in the Clipboard. You can then paste it in a different
location. The original text is preserved.

When you move text to another location, the original text is not preserved. You might
find this method useful when you want to rearrange the sentences and paragraphs in
your document.

To copytext and paste it in another location

1. Selectthetextthatyouwanttocopy.

2. OntheEditmenu,clickCopy.

3. Movethecursortothelocationwhereyouwanttoinsertthecopiedtext.

4. OntheEditmenu,clickPaste.

Tip

 Toquicklycopytext that you've selected, press CTRL+C.Topaste it, press
CTRL+V.

Insertinganddeletingtext
WordPadmakesiteasytoinsertanddeletetextwhereveryouwant.Toinserttext,click
whereyouwanttoinsertthetextandthenjuststarttyping.Todeletetext,selectthetext that you
want to delete, and then press DELETE.

Formattingyour document
Formatting refers to the how the text in your document looks as well as how it is
arranged. WordPad lets you easily change the formatting in your document. For
example, you can choose from many different fonts and font sizes, and you can make



your text almost any color you want. You can also easily change how your document is
aligned.

Tochangethefont,fontstyle,orfont size:

1. Selectthetextwhoseformattingyouwanttochange.

2. OntheFormatmenu,clickFont.

3. IntheFontbox,typeorselectthefontyouwanttouse.

4. IntheFontStylebox,typeorselectthefontstyleyouwant.

5. IntheSizebox,typeorselectthesizeyouwanttouse.

Tochange the color

1. Selectthetextwhosecoloryouwanttochange.

2. OntheFormatmenu,clickFont.

3. UnderColor,clickthecolorthatyouwant.

Tochange the alignment

Youcanalignthetextinyourdocumenttoeithertheleftmargin,thecenter,ortheright margin.

1. Selecttheparagraphwhosealignmentyouwanttochange.

2. OntheFormatmenu,clickParagraph.

3. IntheAlignmentbox,clickthealignmentyouwant.

Savingyourdocument
It'sagoodideatosaveyourdocumentperiodicallywhileyouareworkingonitsothatin case your
computer stops working for some reason, you won't lose any of your work.
Savingthedocumentwillalsoallowyoutocomebacktoitlaterifyouwanttoworkonit again.

Tosavethedocument

 OntheFilemenu,clickSave.

Ifyouhaven'tsavedthedocumentyet,you'llbeaskedtoprovideanameforthe document
and location on your computer to save it to:

1. IntheSaveinbox,clickthelocationwhereyouwanttosavethe
document.

2. IntheFilenamebox,typeanameforyourdocument.

3. ClickSave.



Printingyourdocument
OntheFilemenu,clickPrint.InthePrintdialogbox,usethePageRangeboxandthe Number
of copies box to specify which pages you want to print as well as howmany copies.
When you're done, click Print.



MICROSOFTOFFICE
(MS-WORD,MS-EXCEL,MS-POWERPOINT)

Microsoft Office is an office suite of desktop applications, servers and services for
the MicrosoftWindows and OS X operating systems, introduced byMicrosofton August
1,1989.Initiallyamarketingtermforabundledsetofapplications,thefirstversionof Office
contained Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. Over the years,
Office applications have grown substantially closer with shared features such as a
common spell checker, OLE data integration and Microsoft Visual Basic for Applications
scripting language. Microsoft also positions Office as a development platform for line-
of-business software under the Office Business Applications brand.
Officeisreportedtonowbeusedbyoverabillionpeopleworldwide.

The current versions are Office 2013 for Windows, released on October 11, 2012 and
Office 2011 for OS X, released October 26, 2010. On 24 October 2012, the RTM final
code of Office 2013 Professional Plus has been released to TechNet and MSDN
subscribersfordownload.On15November2012,the60-daytrialversionofOffice2013
Professional Plus was released for download.

MS-WORD
MicrosoftWord is an example of a program called a “word processor.” The key benefit
to using a word processor is that you can make changes easily, including correcting
spelling; adding, deleting, formatting, and relocatingtext; and insertingimages. Once
youcreateadocument,youcaneffortlesslyprintit(asmanycopiesasyouwant!),save
itforlatermodifications, orsend it to afriendvia e-mail. MicrosoftWordis a very powerful
word processor—this handout was created using just a small number of its features!

Microsoft Word is available on both PCs and Macs, so what you learn in class today
shouldbeapplicabletoanycomputeryouuse.Theprogrammaylookslightlydifferent
depending on the version and computer that you’re using, but MicrosoftWord will
functioninthesamebasicways.Thereareotherwordprocessorsoutthere,including
OpenOffice.org Writer, WordPerfect, Apple Pages, and WordPad. They have many
features in common with MicrosoftWord, and you should feel free to choose any
program you prefer.

OpeningMicrosoft Word
To get started with MicrosoftWord (sometimes called “MSWord”), you will need to
locate and open the program on your computer. To open the program, point toWord’s
icononthedesktopwithyourmouseanddouble-clickonitwiththeleftmousebutton.If you
don’t see the MS Word icon on your desktop, you’ll have to access the program
fromtheStartMenu.ClickonthebuttoninthebottomleftcornertopulluptheStart
Menu.YoushouldseetheMSWordiconhere,soclickonitoncewithyourleftbutton.If



you still don’t see it, click on “All Programs” and scroll through the list of programs until
youfindit.Clickoncewith yourleftbuttontoopentheprogram.Occasionally, Microsoft Word
will be in a folder called “Microsoft Office” or something similar—this will make one
more step between “All Programs” and “MicrosoftWord.”

MS Word will then open a blank page called “Document 1.”
This is an image of the upper-left corner of MSWord. This box features two important
piecesofinformation:thenameofthefilethatyouarecurrentlyworkingon(inthiscase,
“Document 1” since we have not yet renamed it) and which programyou are using
(“MicrosoftWord”).Thereshouldnowbeablinkinglineinthetopleftcornerofthepart of
thescreen thatlookslikeasheetofpaper.Thismeansyouwillbeabletotypeinthis space!

MicrosoftWordFeatures

TheTitleBar
This is a close-up view of the Title Bar, where file information is located. It shows the
name of the file (here, “Microsoft Word”) and the name of the program (“Microsoft
Word”).Noticethethreebuttonsontherightside,controllingthesizeandclosingofthe program.
Minimize: Left click this button to shrink the window down to a small button that will
appear in the task bar
Maximize: Left click this button to make the window as large as it can be—it should
take up your entire screen.
Close: Left-click this button to close the window. The program will close and stop
running. Make sure you save your work first!



RestoreDown:
Left-click this button to make the window smaller without minimizing it. The tabbed
Ribbon menu system is how you navigate through Word and access various Word
commands. If you have used previous versions of Word, the Ribbon system replacesthe
traditional menus.

The FileMenu
In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in
the top left-hand corner. In Microsoft Office 2010, this has been replaced with a tab in
the Ribbon called “File.”
When you left-click on this tab, a drop-down menu appears. From this menu, you can
perform the same functions as were found under the Microsoft Office Button menu,
such as: Create a new document, open files, save files in a variety of ways, andprint.
QuickAccessToolbar
On the top left-hand side of the Title Bar, you will see several little icons above the File
menu. These let you perform common tasks, such as saving and undoing, without
havingtofindthem ina menu.We’llgo overthemeaningsof theiconsa littlelater.

The HomeTab

Themostcommonly usedcommandsinMS Wordarealsothemostaccessible.Some of these
commands available in the Home Tab are: The Home Tab Toolbar offers options that
can change the font, size, color, alignment, organization and style of the
textinthedocument.Forexample,the“TimesNewRoman”IndicatestheFONTofyour
text,the“12”indicatestheSIZEofyourtext;etc.Wewillgooverhowtouseallofthese
optionstoformatyourtextinalittlewhile.Eachoftheseoptionsexpandsinto amenuif youleft-
clickonthetinydown-arrowinthebottomrightcornerofthewindow.Theruler
isfoundbelowtheRibbon.Therulertellsyouwhereyouareonthepage,alongwiththe
dimensionsoftheoveralldocument.Justlikearealpieceofpaper,thedefaultsettingis
8.5 x 11 inches, and the margins have been incorporated for you. Similar to most
options in MSWord,this is entirelycustomizable andtheuser cancreate adocumentof any
dimensions.

Keyboard Review

In order to use MS Word effectively, you must input commands using both the mouse
and the keyboard. The above image of a keyboard should look similar to the keyboard
in front of you; learning just a few certain keys will help to improve your efficiency in
typing, as well as present you with more options within the program. The following is a
list of commonly used keys that have special functions in MS Word (key functions can
change depending on which program you are using) :

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondary



Function.

4. Spacebar:Thiskeyentersaspacebetween wordsorletters.

5. Tab:Thiskeywillindentwhatyoutype,ormovethetexttotheright.Thedefault Indent

distance is usually ½ inch.

6. CapsLock:Pressingthiskeywillmakeeveryletteryoutypecapitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.

8. Enter:Thiskeyeithergivesyouanewline,orexecutesa command(pressedin MS

Word, it begins a new line).

9. NumberKeypad:Theseareexactlythesameasthenumbersatthetopofthe

Keyboard; some people just find them easier to use in thisposition.

10. ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocument.

MICROSOFT WORDBASICS

TypingText

To enter text, type just as you would if you were using a typewriter. To capitalize a
letter, hold down the SHIFT key while typing the letter. Or, press the CAPS LOCK keyon
the left-hand side of your keyboard. You will have to press the CAPS LOCK key again—
once you are done capitalizing—to remove the lock. You do not need to press ENTER to
start a new line—MicrosoftWord will automatically wrap your sentence at the end of the
line. To move the cursor from its position at the end of your sentence to anywhereelse
on thepage, use the mouse orthe arrowkeys to move the cursorwhere you want the
letters or spaces to be (left-click the mouse to place the cursor) and then type what you
want toadd—thetext willautomaticallyadjustto include it. PressENTER to starta
newparagraph (this is sometimes called a “carriagereturn”).

Deleting Text

While typing a document, sometimes you will make a mistake. Unlike a typewriter, MS
Word can delete text on the screen and leave no trace—it is as if you never typed on
thepageinthefirstplace.Therearetwodifferentbuttonsonthekeyboardthatwillallow
youtoerasetext.Theyarethe“Delete”keyandthe“Backspace”key(#s1and2onthe keyboard
map on page. The “Backspace” key deletes words to the LEFT of the cursor, and the
“Delete” key deletes words to the RIGHT of the cursor.



BACKSPACE↔ DELETE

Let’sassumethattheverticallinedissectingtheword“creative”intheexampleaboveis our
cursor. Pressing the “Backspace” key will erase “a,” “e,” “r,” “c,” and so on, moving
LEFT.The “Delete”keywillerase “t,”“i,”“v,”“e,”and soon,moving RIGHT.

Todeleteawholechunkoftextatonce,left-clickwithyourmouseanddragtohighlight a section

of text. Then simply press “Backspace” or “Delete” and all of the highlighted Text will

disappear.

Undoingand Redoing

The UNDO and REDO features of Microsoft Windows applications are great tools to rely
on.The program will keepa list of the last25 commandsthat you have performed, and it
allows for taking “one step” backwards in order to erase what you have just done.
ClickontheUNDObuttonintheQuickAccessToolbartogobackonestep.Clickon the REDO
button in the Quick Access Toolbar to go forward one step.

FormattingText

Changing the look of what you’ve written is called “formatting.” This can include
changing the text style, size, color, and more. This is a sentence that features many
different fonts. This is a sentence that features many different sizes. From the Home
Tab,the“B”willmakeyourtextBOLD,the“I”willputitinitalics,andthe“U”willaddan underline to
your text. These features do not have to be used independently of each other—in other
words, you can bold, underline, and italicize a single piece of text. The
alignmentofthetextcanbealteredusingthebuttonswiththehorizontallinesonthem. You can
align text To the LEFT, To the CENTER and to the RIGHT.

In order to apply certain stylistic or formatting changes to text, you must
first HIGHLIGHT the text. This is a common procedure in Microsoft Windows
applications, And because it is so useful, it is a skill worth practicing. You can also
change the font color by clicking on the appropriate buttons inthe

Formatting Toolbar. Experiment and remember—you can always start over with a
fresh, new document, so don’t worry about making mistakes! If you do, however, there
is always the incredible “UNDO” tool. Cutting, Copying, and Pasting Text in MS Word,
you can CUT or COPY text from one area of the document and save that text to be
PASTED elsewhere (these commands are found on the Home Tab). When you CUTtext,
you actually delete it from where you took it, as opposed to COPYING it, which makes a
copy of your selection.

When you CUT or COPY text, it is stored on the CLIPBOARD. The Clipboard is a tool in
MS Word that stores cuts and copies of your work, to be pasted in other places in the
document. Once your selection is on the CLIPBOARD, you can PASTE it as many



times as you want! CUTTING a selection will place it on the clipboard, just in case you
want to PASTE it elsewhere. To CUT a selection, first highlight it. Then, click on
theCUTiconfromtheHomeTab.Thehighlightedtextwilldisappear,asyouhavejustcutit out,
but a copy is now on your clipboard, and MS Word is waiting for you to paste it
somewhere else.

To PASTEthiscutselection,placeyourcursorwhereyouwanttheselectiontogo. Click on the
PASTE icon from the Home Tab toolbar, and it will pop the text into place, right where
you have your cursor. To COPY, simply follow those same steps, replacing
theCUTcommandwithCOPY.TheCOPYcommandwillnotalteryouroriginal
selectionatall,asitsimplymakesacopyoftheselectionwithoutchangingordeletingit in any
way.

DOINGMORE WITHMICROSOFT WORD

InsertingImagesandClipArt

With Microsoft Word, you can insert pictures in your document using the Insert Tab
toolbar. You can insertpictures from the “Clip Art” album that comes with the program,
or you can insert pictures from a file that you have previously saved on a disk or
elsewhere on the computer (e.g., the My Pictures folder).Clip Art is a collection of
cartoon and computer-generated images that cover a broad array of commonly needed
icons and pictures. These include business, holiday, nature, entertainment, academic
and other themes, along with standard bullets and symbols.

To insert a clip art picture into a Microsoft Word document, you will first need to place
your cursor (left-click) where you wish to insert you picture in your document. Then,
from the Inserttab on the Ribbon, click on “Clip Art.” A Clip Artsearch boxwillappear on
the right side of yourscreen. From here,you can entera search word forthe picture you
wouldliketofind.Thenclick“Go.”Thiswillshowalltheoptionsofpicturesyoucan insert.When
you seea pieceof clipart thatyou like, click on it,and it will automatically insert into your
document, in the exact place where you left the cursor. To resize your image,graboneof
thecornersof theimagebyleft-clickingandholding—dragittoyour desiredsizeandfine-
tunethe placement.Thecursorwillchangefrom atypingicontoa double arrow when it can
be used to resize an image.

Drag the corner toward the upper-left corner of the screen, and the image will grow.
Drag toward the bottom-right, and it will shrink. You can move the image to another
place in the document by left-clicking and holding on the center of it; drag it to its
desired location. More options, such as aligning the image with text (or special effects
like wrappingtext around or through an image) can befound byclickingon thepicture,
and then choosing the Picture Tools Tab. You can also insert a photograph or other
images from your files using this same process. On the Insert Tab, click on Picture and
locate the files that you want to include.



ModifyingLine Spacing

LinespacinginWordreferstotheamountofspacebetweenlinesof text.Thedefaultin Word
2010 is 1.15 spacing, which leaves a little bit more space than single-spacing, or what
you would find in a normal book. Single spacing is generally easy for the eye to read.
There may be times, however, when you want to change this spacing. One common
option is to double-space text: This text is double-spaced. Double-spacing is especially
useful if someone else is proof reading your document. It allows for more room to write
comments on the page.

Tochange theline spacing:

1. Selecttextyouwanttoformatbyhighlightingit.

2. OntheHomeTab,clickontheLineSpacingbuttonintheParagraphgroup.

3. Choose the spacing you want from the menu that appears. For more options, select
Line Spacing Options. In the dialog box that appears, you can choose other spacing
options, including spacing between paragraphs. This can be done by changing the
values in the Before and After boxes.

CreatingBulletedandNumbered Lists

Word allows you to create lists within yourdocument that can be organized with bullets
or numbers. Lists are useful for presenting text that wouldn’t make the most sense in
paragraph form (for example, step-by-step instructions) or for emphasizing key points
Bullets are usually small circles at the beginning of item in a list, and numbers are used
for lists that are arranged in sequential order.Here’s an example of a bulleted list:

 Bananas
 Milk
 Eggs
 IceCream

Tocreatealist:

1. On the Home tab, select either the Bullets or Numbering buttons from the Paragraph
group. If you want to choose a particular style for your bullets or numbers, click on the
triangle next to thebutton and choose astyle from themenuthatappears.

2. You will see the first bullet or number appear on your document. Type your first line
of text and then hit Enter.

3. Anotherbulletornumberwillappearautomatically.Typeyournextlineoftextandhit Enter.

4. Whenyouhavefinishedyourlist,hitEntertwicetoendthebulletsornumbering.



ChangingViewsandOverall Look

There will be times when you need to create documents that don’t fit on a standard
piece of paper (8.5” by 11”).

ClickonthePageLayoutTab.

From this menu, you can alter the margins, width, height, and orientation (portrait =
11”14long; landscape = 11” wide) of the document, as well as choose from a variety of
templates,differenttypesofpaper,anddocumentstylesthatcomewiththeprogram.To change
the orientation of your page, click on the Orientation button.

Click on Landscape from the drop-down box that appears. Your document should now
be in landscape position. If you wish to return to portrait orientation, go through the
same steps, clicking on the Landscape option instead of Portrait. If you would like to
change the displayofyourdocument orzoom in and out withoutaffectingthe wayyour
document will print, you can do that from the View Tab. Anything you change from the
ViewTab will not change the way your document printsout.So if you want your text to
be bigger when you print out the document, make sure to change the size of the font
instead of the zoom.

SpellingandGrammar Check

One benefit of using a computerized word processor is its ability to recognize, change,
and give advice about your writing. MS Word has utilities that can check your spelling
and grammar against a master database, and can offer advice on a variety of different
grammatical styles. MS Word automatically underlines any words that it does not
recognizeinred,assumingthattheyarenotspelledcorrectly,andunderlinesingreenif it does
not recognize the grammatical pattern, assuming that the sentence does not make
sense.

For example: In this case, “jumping” should read “jump” and “laziy” should be “lazy.” If
yourightclickontheword,amenuwithpopupwithoptions,including“Ignore”ifyoudo not want
help on thisspecificphrase oragree with the suggestion. You can also choose to add
words to the MSWord spelling database, if you are going to use them often and don’t
want them to be flagged as misspelled every time—this is especially useful for names,
as MS Word often interprets these as misspellings. The spelling and grammar tools can
be found in the Review Tab

USINGMICROSOFTWORD

MicrosoftWord is an example of a program called a “word processor.”Word processors
areusedtocreateandprinttextdocumentsinmuchthesamewaythatyouwouldusea typewriter.
The key benefit to using a word processor is that you can make changes
easily,includingcorrectingspelling;adding,deleting,formatting,andrelocatingtext;and
inserting images. Once you create a document, you can effortlessly print it (as many
copiesasyou want!),save it forlatermodifications,orsend it to afriend via e-mail.



MicrosoftWord is a very powerful word processor—This handout was created using just
a small number of its features! Microsoft Word is available on both PCs and Macs, so
what you learn in class today should be applicable to any computer you use. The
program may look slightly different depending on the version and computer that you’re
using, but Microsoft Word will function in the same basic ways. There are other word
processors out there, including OpenOffice.org Writer, WordPerfect, Apple Pages, and
WordPad. They have many features in common with Microsoft Word, and you should
feel free to choose any program you prefer.

OpeningMicrosoft Word

To get started with Microsoft Word (sometimes called “MS Word”), you will need to
locate and open the program on your computer. To open the program, point to Word’s
icononthedesktopwithyourmouseanddouble-clickonitwiththeleftmousebutton.If you don’t
see the MS Word icon on your desktop, you’ll have to access the program from the
Start Menu. Click on the button in the bottom left corner to pull up the Start
Menu.YoushouldseetheMSWordiconhere,soclickonitoncewithyourleftbutton.If you still
don’t see it, click on “All Programs” and scroll through the list of programs until
youfindit.Clickoncewith yourleftbuttontoopentheprogram.

Occasionally, Microsoft Word will be in a folder called “Microsoft Office” or something
similar—this will make one more step between “All Programs” and “MicrosoftWord.”MS
Wordwillthenopenablankpagecalled“Document1.”Thisisanimageoftheupper-left corner of
MSWord. This box features two important pieces of information: the name of thefilethat
youare currently workingon (in this case,“Document 1” since we have not yet renamed
it) and which program you are using (“MicrosoftWord”).There should now
beablinkinglineinthetopleftcornerofthepartofthescreenthatlookslikeasheetof paper. This
means you will be able to type in this space!

MICROSOFT WORDBASICS

TypingText

To enter text, type just as you would if you were using a typewriter. To capitalize a
letter, hold down the SHIFT key while typing the letter. Or, press the CAPS LOCK keyon
the left-hand side of your keyboard. You will have to press the CAPS LOCK key again—
once you are done capitalizing—to remove the lock. You do not need to press ENTER to
start a new line—MicrosoftWord will automatically wrap your sentence at the end of the
line. To move the cursor from its position at the end of your sentence to anywhere else
on thepage, use the mouse or the arrowkeys to move the cursor where you want the
letters or spaces to be (left-click the mouse to place the cursor) and then type what you
want toadd—thetext will automaticallyadjustto include it. PressENTER to starta
newparagraph (this is sometimes called a “carriagereturn”).



Deleting Text

While typing a document, sometimes you will make a mistake. Unlike a typewriter, MS
Word can delete text on the screen and leave no trace—it is as if you never typed on
thepageinthefirstplace.Therearetwodifferentbuttonsonthekeyboardthatwillallow
youtoerasetext.Theyarethe“Delete”keyandthe“Backspace”key(#s1and2onthe keyboard
map on page.

The “Backspace” key deletes words to the LEFT of the cursor, and the “Delete” key
deletes words to the RIGHT of the cursor.

MicrosoftWordFeatures

The Title Bar

This is a close-up view of the Title Bar, where file information is located. It shows the
name of the file (here, “Microsoft Word”) and the name of the program (“Microsoft
Word”).Noticethethreebuttonsontherightside,controllingthesizeandclosingofthe program.

Minimize: Left click this button to shrink the window down to a small button that will
appear in the task bar

Maximize: Left click this button to make the window as large as it can be—it should
take up your entire screen.

Close: Left-click this button to close the window. The program will close and stop
running. Make sure you save your work first!

RestoreDown:Left-clickthisbuttontomakethewindowsmallerwithoutminimizingit.

The FileMenu

In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in
the top left-hand corner. In Microsoft Office 2010, this has been replaced with a tab in
the Ribbon called “File.” When you left-click on this tab, a drop-down menu appears.
From thismenu,youcanperformthesamefunctionsaswerefoundundertheMicrosoft Office
Buttonmenu, such as: Create anewdocument, openexistingfiles, save files ina variety of
ways, and print.

TheHomeTab

Themostcommonly usedcommandsinMS Wordarealsothe mostaccessible.Some of these
commands available in the Home Tab are: The Home Tab Toolbar offers options that
can change the font, size, color, alignment, organization and style of the text in
thedocument.For example,the “Times NewRoman” indicates the FONT of your
text,the“12”indicatestheSIZEofyourtext;etc.Wewillgooverhowtouseallof these



optionstoformatyourtextinalittlewhile.Eachoftheseoptionsexpandsintoamenuif youleft-
clickonthetinydown-arrowinthebottomrightcornerofthewindow.

The Ruler

The ruler is found below the Ribbon. The ruler tells you where you are on the page,
along with the dimensions of the overall document. Just like a real piece of paper, the
default setting is 8.5 x 11 inches, and the margins have been incorporated for you.
Similar to most options in MS Word, this is entirely customizable and the user cancreate
a document of any dimensions.

Keyboard Review

In order to use MS Word effectively, you must input commands using both the mouse
and the keyboard. The above image of a keyboard should look similar to the keyboard
in front of you; learning just a few certain keys will help to improve your efficiency in
typing, as well as present you with more options within the program. The following is a
list of commonly used keys that have special functions in MS Word (key functions can
change depending on which program you are using)

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.

4. Spacebar:Thiskeyentersaspacebetween wordsorletters.

5. Tab: This key will indent what you type, or move the text to the right. The default
indent distance is usually ½ inch. 6. Caps Lock: Pressing this key will make every letter
you type capitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.

8. Enter: This key either gives you a new line, or executes a command (pressed in MS
Word, it begins a new line).

9. Number Keypad: These are exactly the same as the numbers at the top of the
keyboard; some people just find them easier to use in this position.

10. Arrow Keys: Like the mouse, these keys are used to navigate through a document
or page.



MICROSOFTEXCEL
Microsoft Excel is an example of a program called a “spreadsheet.” Spreadsheets are
used to organize real world data, such as a check register or a rolodex. Data can be
numerical or alphanumeric (involving letters or numbers). The key benefit to using a
spreadsheet program is that you can make changes easily, including correcting spelling
or values, adding, deleting, formatting, and relocating data. You can also program the
spreadsheet to perform certain functions automatically (such as addition and
subtraction), and a spreadsheet can hold almost limitless amounts of data—a whole
filing cabinet’s worth of information can be included in a single spreadsheet. Once you
createa spreadsheet,you caneffortlesslyprint it(asmanycopiesasyou want!),save it for
later modifications, or send it to a colleague via e-mail. Microsoft Excel is a very
powerful.

OpeningMicrosoftExcel
To get started with Microsoft Excel (often called “Excel”), you will need to locate and
open the program on your computer. To open the program, point to Excel’s icon on the
desktop with your mouse and double-click on it with the left mouse button. If you don’t
see the Excel icon on your desktop, you’ll have to access the program from the Start
Menu. Click on the button in the bottom left corner to pull up the Start Menu. You may
see the Excel icon here, so click on it once with your left button. If you still don’t see it,
click on “All Programs” and scroll through the list of programs until you find it. It may
also be located in a folder called “Microsoft Office” or something similar—it will depend
on your specific machine. Click once with your left button to open the program. Excel
will then open a blank page called “Book1.”

MicrosoftExcelFeatures



The Title Bar
This is a close-up view of the Title Bar, where file information is located. It shows the
name of the file (here, “Book1,” the default title) and the name of the program
(“Microsoft Excel”). You will be able to name your file something new the first time that
yousaveit.NoticethethreebuttonsontherightsideoftheTitleBar,controllingthesize and
closing of the program.

TheRibbon Menu System
ThetabbedRibbonmenusystemishowyounavigatethroughExcelandaccess various Excel
commands. If you have used previous versions of Excel, the Ribbon system replaces
the traditional menus. At the bottom, left area of the spreadsheet, you
willfindworksheettabs.Bydefault,threeworksheettabsappeareachtimeyoucreatea new
workbook. On the bottom, right area of the spreadsheet you will find page view
commands, the zoom tool, and the horizontal scrolling bar.

The FileMenu
In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in
the top left-hand corner. In Microsoft Office 2010, this has been replaced with a tab in
the Ribbon called “File.”When you left-click on this tab, a drop-down menu appears.
Fromthismenu,youcan performthesamefunctionsaswerefoundundertheMicrosoft Office
Button menu, such as: Create a new worksheet, open existing files, save files ina
variety of ways, and print.6
Quick Access Toolbar On the top left-hand side of the Title Bar, you will see severallittle
icons above the File menu. These let you perform common tasks, such as saving and
undoing, without having to find them in a menu.We’ll go over the meanings of the icons
a little later.

TheHomeTab
The most commonly used commands in Excel are also the most accessible. Some of
these commands available in the Home Tab are: The Home Tab Toolbar offers options
thatcanchangethefont,size,color,alignment,organizationandstyleof thetextinthe
spreadsheet and individual cells. For example, the “Calibri” indicates the FONT of your
text;the“11”indicatestheSIZEofyourtext;etc.Wewillgooverhowtouseallofthese
optionstoformatyourtextinalittlewhile.Eachoftheseoptionsexpandsintoamenuif you left-
click on the tinydown-arrow in the bottom right corner of the window. This tab works
the exact same way as the MS Word Formatting Toolbar. The main difference is that
the format changes will only affect the selected cell or cells, all unselected cells
remaininthedefaultsetting(“Calibri”font,size“11”).

Equation Editor
The Equation Editor is generally found below the ribbon menu. The left side denotes
which cellis selected (“C5”)andtheright side allows you toinputequationsor text into the
selected cell.
There are two ways to input information into a cell. You may either select an individual
cellandtypetheequationortextintotheequationeditorortypetheequationortext



directlyinto the selected cell. Equations (forexample, =SUM(D5+E5)) will automatically
be hidden inside the cell and canonlybe viewed using the equation editor; the resultof
theequationwilldisplayinthecell.Ifanywrittentextislongerthanthecellwidth,then
thespreadsheetwillcoverupanyportionlongerthanthe cellwidth.Theinformationwill stillbe
in the cell, you just won’tbeableto see it atalltimes.

Keyboard Review
In order to use Excel effectively, you must input commands using both the mouse and
the keyboard. The above image of a keyboard should look similar to the keyboard in
frontofyou;learningjustafewcertainkeyswillhelptoimproveyourefficiencyintyping as well
as present you with more options within the program. The following is a list of
commonly used keys that you may already be familiar with:
1. Backspace:Thiskeydeleteslettersbackwards.
2. Delete:Thiskeydeleteslettersforward.
3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.
4. Spacebar:Thiskeyentersaspacebetween wordsorletters.
5. Tab:Thiskeywillindentwhatyoutype,ormovethetexttotheright.Thedefault indent
distance is usually ½ inch.
6. CapsLock:Pressingthiskeywillmakeeveryletteryoutypecapitalized.
7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.
8. Enter:Thiskeyeithergivesyouanewline,orexecutesacommand.
9. NumberKeypad:Theseareexactlythesameasthenumbersatthetopofthe
keyboard; some people just find them easier to use in this position.
10. ArrowKeys:Likethemouse,thesekeys areusedtonavigatethroughadocument or page.

Pointer Shapes
As with other Microsoft programs, the pointer often changes its shape as you work in
Excel.Eachpointershapeindicatesadifferentmodeofoperation.Thistableshowsthe various
pointer shapes you may see while working in Excel.

MICROSOFTEXCEL BASICS

Formatting Cells
Cells are the small rectangular boxes that make up the spreadsheet. All the information
entered into an Excel spreadsheet is entered into cells. The cell width and height will
usuallyneed to be adjusted to viewall the information entered into a cell.

To adjust the cell width, move the mouse pointer in between two cell columns in the
columnheader.Holddowntheleftmousebuttonanddragthemouselefttoshortenthe width or
right to expand the width. Notice that all cells within the column are automatically
adjusted. Adjust the cell height using the same method. Move the mouse cursor
between two rows, hold down the left mouse button and move the mouse up to
decrease the height and down to increase the height. Before you begin entering data
into a spreadsheet, you may already know the width and height you want your cells to
have. In this case, you can adjust all the widths and heights by doing the following:
Select the “square” between Column A and Row 1.



This will select ALL the cells in the spreadsheet. From the “Home” tab of the Ribbon
Menu, within the “Cells” box, click on “Format,” and select Row Height. You will nowbe
asked to enter a numerical value for height. The default value is 15, but you can enter
your own height value (10, 20, 25, etc.).

Repeat the same steps for Column width. From the “Home” tab of the Ribbon Menu,
withinthe“Cells”box,clickon“Format,”andselectColumnWidth.Notethatthedefault
valueforthewidthis8.43.Enteryourownwidthvalue(5,10,15,20,etc.).

For any given cell or selected cells, you can also format the way your data is
represented within the cell(s). Select a single cell or multiple cells.
Again,fromthe“Home”taboftheRibbonMenu,withinthe“Cells”box,clickonFormat.” Select
“Format Cells.”The format window will now appear, giving you a wide variety of options
on how to format your cell.

Number– This allows youtochoose how torepresentthe numbers that are entered into a
cell (number, currency, time, etc.).
Alignment–Thisdetermineshowthedatawillbealignedwithinthecell(left-side, centered, or right-
side).
Font–Selectthetypeoffonttobeusedwithinthecells.
Border –Thisoptionletsyouchoosewhattypeofborder,ifany,youwouldlikearound the cells
or some of the cells.
Fill –Thisallowsyoutochangethebackgroundcolorofthecell.
Protection –Thisoptionallowsyouto“lock”cellinformationsothatotheruserscannot make
changes.
TypinginCells
Click on a cell to begin typing in it. It is that easy! When you are finished typing in the
cell,presstheEnterkeyandyouwillbetakentothenextcelldown.Youcanthenbegin typingin
that cell. You can easilynavigate around the cells usingyourarrowkeys. Keep in mind
that the Formatting toolbar in Microsoft Excel 2010 is exactly the same as the one used
for MicrosoftWord 2010. The biggest difference between the two programs is that, in
Excel, the format is set for each individual cell.

So if you change the font and applied the bold option in cell C5, then this format will
onlybe applied to cellC5. Allremainingcells will remain in defaultmode until theyhave
beenchanged.Sometimesyoumayonlywishtoadjusttheformatof oneparticularcell. In this
case, simply select the cell by clicking the mouse on it and make any necessary
adjustments to the font, size, style, and alignment. Those changes will not carry over
whenyoubegintypinginanewcell.Othertimes,youmaywishtoadjustthetextformat of a
group of cells, entire rows, or entire columns.

In Excel, you can choose groups of cells in rectangular units—all
the cells you select must form a rectangle of some kind. To select a group of cells,begin
by clicking on the cell that would be in the upper-left hand corner of your
rectangle.HolddowntheShiftkeyonyourkeyboardandusethearrows(←,→,↑,↓)on
thekeyboard toexpandtheselection ofcells,or clickanddrag your mouse.Oncethe



group of cellshasbeen selected,you canmake adjustments to thefont, size, style, and
alignment and they will be applied to all selected cells.

Toselectanentirerow,clickontheRowNumberwithyourmouse—notehowtheentire row
becomes highlighted. All formatting changes will now be applied to the whole row. To
select an entire column, click on the Column Number with your mouse—again, the
entire column will become highlighted. All formatting changes will be applied to the
whole column.

InsertingRowsand Columns.
When you are working on a spreadsheet, you may realize that you left out a row or
column ofdataandneed toaddit in.Toinsert a row, click on the rowbelowwhere you want
your new row to be (remember to click on the row number to highlight the entire
row).Fromthe“Home”tab,withinthe“Cells”box,click“Insert.”Select

“Insert Sheet Rows.” A new row will automatically be inserted and the row numbers
automaticallyadjusted.Toinsertacolumn,clickonthecolumntotherightofwhereyou want
your new column to be (remember to click on the column letter to highlight the
entirecolumn).Fromthe“Home”tab,withinthe“Cells”box,click“Insert.”Select“Insert sheet
Columns.” A new column will automatically be inserted and the column letters
automatically adjusted.

SortingData
Once you have created your spreadsheet and entered in some data, you may want to
organize the data in a certain way. This could be alphabetically, numerically, or another
way. Let’s look at the following spreadsheet as an example. This information can be
sorted by check number, date, alphabetically by description, or using any of the other
columns.

First, select all the cells that represent the data to be sorted, including the header
descriptions (Check No., Date, Description, etc.). Then, select the first cell in Row 1
(CheckNo.)Clickanddragtoselectallthecellsthatyouwanttosort.Usingthemouse, select Sort
& Filter from the Editing panel. Select Custom Sort…
Select the column you wish to sort by. Do you want to sort by alphabetical order,
reverse alphabetical order, date, or amount? When you press “OK,” your spreadsheet
will be sorted in the order that you specified.

AutoSumandExcelEquations
One of the most powerful features of Excel is its ability to perform basic math functions
ondata.Excelcanadd,subtract,multiply,divide,findtheaverage,andperformgeneral
countingfunctionsonthenumericaldatathatyouenter.Toenablethisfeature,highlight all of
the cells in a column,plus one additional emptycell in which to displaythe result.

SelecttheAutoSumiconfromtheribbonmenu:
If you click directly on the ∑, Excel will automatically add up the numbers you have
selected. If you click on the little dropdown arrow next to it (▼), you will get the full
choice of mathematicalfunctions. If you double-click on the cell in which the answer



appears, you will see an equation that looks something like this (you will also see this
equation in the Equation Editor):
Let’sbreakdownwhatexactlytheequationmeans:
=indicatesthatyouarestartinganequationinthiscell.
SUMtellsthefunctiontobeperformed.Inthiscase,allthecellswillbeaddedtogether.
( )Theparentheses containthecells that thefunction will be performedon.
D2thisisthefirstcelltobeincludedintheadditionformula.
D8 this is the last cell to be included in the addition formula indicates that all cells
between the first and the last should be included in the formula.
The spreadsheet will often “select” the cells that it thinks you wish to include. But you
can manually change the cell range by typing into the Equation Editor. When you are
ready to execute the formula, just press the “Enter” key. Other mathematical functions
you can perform from the AutoSum button include:
Average – This function will calculate the average of the selected cells.
CountNumbers–Thisfunctionsimplycountsthenumberof cellsselected. Max –
This function will return the highest value of the selected cells.
Min–Thisfunctionwillreturnthelowestvalueoftheselectedcells.
*Remember* Excel equations are similar to programming languages, so have some
patience and if at first you don’t succeed, try again. Even Excel professionals create
incorrect formulas on their first try.
Onceyougetanequationtowork,youwilltechnicallybeacomputerprogrammer!
Creating Charts andGraphs:
InExcel,therearealsowaystorepresentyourdatainchartorgraphicalforms.
Tocreateachartorgraph,selecttheInserttabfromtheRibbonMenubar.Inthe middle
ofthisnewmenu,youwillseea“Charts”box.
1. Select the range of data to be represented in the chart or graph. Click on your
spreadsheet and select the data to be represented using the same method that you
used to select data in the sorting exercise. For this example, we want to see a visual
comparison of how much money we spent on each item in the list. Select rows 1
through 8 in rows B, C, and D.
2. Select the type of chart or graph you wish to create (for our example, we’ll choose a
bar graph).
3. Onceyouhavecreatedyourgraph,youcannow“customize”itbygivingitatitleand labeling
different parts. You can also make certain design decisions regarding the appearance of
your graph or chart by choosing the different elements under the Design tab that
appears on the Ribbon Menu bar.
4. Finally, you will need to decide if your chart should be pasted on to the existing
spreadsheet or if it should be pasted on to a brand newsheet. On the veryright side of
theRibbon Menu bar,selectMoveChart.Oncethechart or graphhas been created
andyourealizeamistakehasbeenmadeoritdidnotturnoutthewayyouwanteditto, simplyclick
on the chart or graph and hit theBackspace keyon your keyboard todelete it from your
spreadsheet. Don’t be afraid to go back and tryagain!



Multiple Sheets

Sometimes you may find it useful to have multiple spreadsheets for related data. For
example, personal finances are usually tracked on a monthly calendar and it’s generally
good idea to keep records of the past transactions. Excel can create multiple
spreadsheetsattachedtothesameExcelfile,oneforeachmonth.Tabsforthedifferent sheets
are located in the lower-left corner of the spreadsheet. The spreadsheet that is
currently being worked on is on the top tab. To access another spreadsheet, select the
appropriate tab, such as Sheet 2. The default names for the sheets are usually Sheet1,
Sheet2, and Sheet3. To rename a sheet or to create a new sheet, simply move the
mouse pointer over the sheet name and right-click. Select “Rename” to rename the
sheet or select “Insert” to create a new sheet.

You can transfer cell information between two or more sheets by creating a simple
formula. For example, most people who keep track of their personal finances don’t
begin every month with a balance of $0. Instead, the balance at the beginning of the
monthistransferredoverfromthepreviousmonth.SoifyouhaveaMarch2012finance
spreadsheet and an April 2012 finance spreadsheet, you can select a cell in the April
2012 sheet and write in the formula

=‘March2012’! D11
The equals sign (=) tells Excel that the value for this cell is to be derived from
somewhere in the spreadsheet (such as a formula or another cell location).
‘Sheet name’ tells Excel what sheet to refer to when it retrieves the value. The single
quotation marks (‘ ‘) are important. ! D11 tells Excel that it is to copy the value that is
located in cell D11 (or whatever cells you wish to copy the value from).
If you wanttotransfercellinformationfromone celltoanotheronthe same sheet,you can
use the exact same formula; just exclude ‘Sheet name.’

DOINGMOREWITHMICROSOFTEXCEL

Cutting,Copying,andPastingData
When you are typing in your spreadsheet, it can be veryhelpful to cut or copy
informationfromonecellandpasteitintoanother.Thiscanhelpreducetheamountof typing
you have todo,aswellaslimitthe numberof typographicalerrors.Cutting,
copying,andpastingthecontentsofcellsinExcelisverysimilartothewayyoudoitin Microsoft
Word.
Thesecommandsare allaccessible from theHome tabon theRibbonMenubar.
ToCUTthe contents of a cell, click on the cell to select it, then click on the Cut button
on the Hometab. Youwillsee theborderofthe cellturn into little “marchingants.”The
contents are now on the Clipboard, ready for you to paste them somewhereelse.

To PASTE the cut selection somewhere else, click on the cell where you want the
selection to go.Then click on the Paste button on the Home tab.The selection will now
appear in the new cell and be removed from the original cell.



To COPY the contents of a cell, simplyfollowthe directionsabove but replace the CUT
command with COPY. This will leave the contents of the original cell in place and make
an exact copy of them in another cell.

FillingDataacrossColumnsand Rows
Anotherwaytocopytextfromonecelltoanotheristodragitor“fill”itacrossarangeof
cells(aroworacolumn).Thisisagreatmethodifyouwant allthetext(ornumbers)in column or
row to be the same. For example, if you have a spreadsheet for your yearly
budgetwithacolumnforrent,youcouldusethismethodtofillinallthecellsintherent column with
the same number without re-typing.

Tofillthecontentsofcellsinacolumn:
1. Clickonthecellwiththeinformationyouwanttocopytotheothercells.
2. Hoveryourmouseoverthelittlesquare(calleda“fillhandle”)inthebottomright corner
of the highlighted cell border. Your mouse will turn into across.
3. Clickonthefillhandleanddragyourmouse(whilestillholdingthebuttondown)
downthecolumnuntilyou’vehighlightedallthecellswhereyouwantthetexttogo.
4. Letgoofthemousebutton.Thetextwillnowappearinallthecellsyouhighlighted.
5. Youcanfollowthesesamestepstofillthecontentsofarowratherthanacolumn— simply
drag your mouse across the row instead of down the column.
You canalso use thistechnique to copyformulas across columnsand rowsin the
spreadsheet.

CLOSINGMICROSOFTEXCEL

SavingSpreadsheets

When you finish your spreadsheet and want to leave the computer, it is important to
save your work, even if you are printing a hard copy. To save your work in Excel, it is
essential to know WHAT you are trying to save and WHERE you are trying to save it.
Click on the FileTab, then click “Save As” to get started.You canchange thefilename
that Excel has chosen just by typing a new one in the “File name” box at the bottom of
the window that appears. The My Documents folder on your computer’s hard drive is a
good placetostoreyour documents. AblankCD or aUSBjumpdrive are greatportable
storage options and can contain a LOT of data. Excel will automatically save your
document with the suffix “.xlsx”–this is simply a tag that lets Excel knowthat your work
is specific to this program and what version it is in. You do not have to type it–just
highlight what is there (default is “Book1”) and write a new file name. You may also
chose to save itin an olderformat so that itcan be opened with olderversionsof Excel.
After the first save, you can just click “Save” to preserve your work.

However, it is important to note that every following command of SAVE will overwrite
your original file, creating the most up-to-date version. If you would like to keep saving
different versions of your worksheet, be sure to use the “Save As” function each time
you save, using a slightly different name for each version.



Printing Spreadsheets
To print your Excel document, click on the File Tab, then click “Print” from the left-side
column. A Print Preview and printing options will appear in your Excel window.
Clickthe large “Print” button to send yourworksheetto the printer.You can change the
number of copies you would like to print, change the paper orientation, choose which
printer you want to use, and more.

Finding More Help
You can get help with Excel by clicking on the Question Mark symbol in the upper-right
hand corner of the main menu bar or by pressing the “F1” button. This will take you to
help from Office.com, Microsoft’s help website. There are also many other resourcesand
tutorials available online. You might try a Google search with the words “Excel 2010”
and the function you are trying to perform. Ask your instructor for help finding these
resources if you have any trouble.

Closing the Program
ClickontheFileTab,thenclick“Exit.” OR
ClickontheXinthetoprightcorneroftheExcelscreen.

MICROSOFTPOWERPOINT
Microsoft PowerPoint is a professional presentation program that allows the user to
create "presentation slides" that can be displayed on the computer screen or through a
projectorthatispluggedintothecomputer.APowerPointpresentationisagoodwayto convey
pieces of information, usually in the form of an outline, to a large audience. Generally,
PowerPoint presentations are appealing to users because they are easy to create and
edit and generally small enough to fit onto a CD or a USB Jump Drive. Therefore, a user
does not have to carry around any slides or a slide project, and, if necessary, can make
last-minute changes to the presentation.



MicrosoftPowerPointComponents:

Before you get started with Microsoft PowerPoint (commonly referred to asPowerPoint),
you will need to locate and open it on the computer. It may be on your desktop.
Onthecomputerdesktop:
1. Double-clickontheMSPowerPointicon
IftheMSPowerPointiconisnotonthedesktop,gototheStartmenu:
1. Click ►Start►Programs►MicrosoftPowerPoint*
MSPowerPointwillopenablankpagecalled"Presentation1."

TheTitleBar
This is a close-up view of the Title Bar, where file information is located. Notice the
default title "Presentation1." You will get a chance to rename your presentation slides
the first time you choose to save it.

TheMenu Bar
The Menu Bar is a common sight in almost all MicrosoftWindows programs. It features
text based menus, on which virtually every option available to the user in the entire
program is listed.
Each menu expands when clicked (with the left mouse button), offering many options
categorized by specific tasks.



Standard Toolbar
Toolbars provide "shortcuts" to commands also found in the Menu Bar. Toolbars are
usually located just below the Menu Bar and exist to offer another way to perform the
same task.
The most commonly used commands in MS PowerPoint are also the most accessible.
Some of these commands are:
New|Open |Save| Print| Preview|Spell-check|Copy|Paste|Undo| Insert

Formatting Toolbar
The Formatting Toolbar offers options that can change the font, size, color, alignment,
organization,andstyleofthetextinthepresentationslides.Forexample,(startingfrom
theleftsideoftheToolbar)the"Arial"indicatestheFONTofyourtext;the"32"indicates the SIZE
of your text; and so on. This toolbar works the exact same way as the MS
WordFormattingToolbar.Themaindifferenceisthattheformatchangeswillonly affect the
text box in which you are currentlyworking.
Allothertextboxeswillremaininthedefaultsetting("Arial"font,size"32").Design/New Slide
Icons additional shortcut icons appear on the MS PowerPoint toolbar: the Design icon
and the New Slide icon. Both commands are frequently used, and it is good to be
familiar with their location on the toolbar.

The Design icon is a shortcut to the slide design page. Here you will
be able to create and edit the appearance of your slide(s). The New Slide icon
automatically adds a new, blank slide for you to work on. You can keep track of the
slides you have already worked on in the Slide Outline box on the left-hand side of the
screen. You can access a slide at any time by clicking on it with your mouse throughthis
screen.

SIMPLETASKSINMICROSOFTPOWERPOINT
Text Boxes:
Text Boxes are "designated" areas that allow you to type words, sentences, and bullet
points into the slide. You can adjust the size and placement of the text box within any
given slide. It is also possible to have multiple text boxes per slide.

When you first open MS PowerPoint, there will automatically be two text boxes on the
slide:

"Click to add title" and "Click to add subtitle." These text boxes already have a preset
formatappliedtothem.The"title"boxhasafontsizeof"44"whilethe"subtitle"boxhas a font
size of "32." You can change the text format of any box at anytime by adjusting the
format settings on the Formatting Toolbar. To adjust the size of the text box, first click
on the text box. Notice the change in border. Once you have clicked on atext box,
theborderof theboxbecomesthickerandlittlecirclesappearonthecornersandatthe midpoints
of the box. Move the mouse pointer over any one of the circles. Notice that the mouse
pointer will change to either ↔ or ↕. Click and hold down the left mouse
button.Toadjusttheheight,movethemouseupordown;toadjustthewidth,movethe mouse
left or right. Note that the corner circles can adjust both height and width, while the
mid-point circles can onlyadjust either height orwidth.



Tomovethetextboxtoadifferentlocationontheslide,moveyourmousepointerover any part
of the thick, gray box outline. Notice the change in your mouse pointer (it will
looksomethinglikea"plus"sign(+)witharrows).Clickandholddowntheleftbuttonon your
mouse. You can now drag the text box to any position on the slide by simply
movingyourmouse.To write in atext box, simplyclick insidetheboxwith yourmouse. When
a cursor is flashing, you are ready to type.

Slide Design:

One of the more popular features of MS PowerPoint is that it gives the use a wide
variety of design choices. At some point, you may wish to change the design andcolor
ofthebackgroundofyourslides.Todoso,simplyclickontheDesignicon.Ontheright- hand
sideofyourscreen,the"Slide Design"pane willappear.Here,you aregiven three design
options to apply to your slides.

DesignTemplates: Here is a list of over 20 templates that you can choose from to
apply to the background of your slides. For each template, you have the option of
applyingthedesigntoallslidesortoonlytheselectedslide.Youcanviewtheseoptions by clicking
on the arrow on the right side of the template. If you are connected to the Internet,
you can also choose to view hundreds of additional templates by choosing "Design
Templates on Microsoft Office Online" on the bottom of the templatescreen.

Color Schemes: This option gives you a variety of color schemes to choose from to
apply to your selected design template.

Animation Schemes: This option will allow you to select different types of animation
that can be applied to either all the slides or selected slides. The animation schemesare
different ways the slides are "introduced" to your audience,such as "faded wipe" or
"pinwheel."

Designingyour ownbackground:

Sometimesyoumaywishtodesignyourownbackground.

To do this, select Format ► Background… from the Menu Bar. Select the Color Bar on
the bottom of the Background window and choose the appropriate color and or/effects
that you desire. There is no right or wrong way to design your own background, so if
you choose this option, have some patience and don't be afraid toexperiment.

Slide Layout:

The default in PowerPoint for each new slide is to have a Title text box and a Text box.
As discussed earlier, you do have the option of rearranging the text boxes to fit any
layout you have in mind. However, sometimes it will be easier simply to select a layout
thatfitsyourneedsratherthanreformattingthedefaultlayoutforeachslide.Tochoose a slide
layout, select Format ► Slide Layout from the Menu Bar. On the right-hand side of your
screen, the "Slide Layout" pane will appear. From here, you have the option of



applying a slide layout either to a selected slide or to a new slide that has yet to be
inserted. You can view these options by clicking on the arrow on the right side of the
template.

Notethefourdifferenttypesoflayout categories.

Text Layout: These options are for choosing a layout in which you are only organizing
different text boxes. There is no room for pictures, charts, or graphs.

Content Layout: Theseoptionsareforchoosingalayoutthatwillonlycontainpictures, charts,
or graphs. There is no room for text boxes.

Text and Content Layout: These options have room for both text boxes and pictures,
charts, or graphs.

Other Layouts: Theselayoutsaredesignedforothermediacontentsuchasvideoclips or
audio tracks.

Inserting a Picture:

Inserting a picture into MS PowerPoint is very similar to inserting a picture into MS
Word.

1. Selecttheslidethatyouwishtoaddapictureto.

2. FromtheMenuBar,selectInsert►Picture►FromFile(orClipArt).

3. Choosethepictureyouwishtoinsertandselect"Insert."

*Note*: The picture will be inserted in its original size, so you will probably have to re-
size it. You can re-size a picture the same way you re-sized a text box. Click on the
pictureandnote the circlesat the cornersand atthemidpoints of the length and width.
Move your mouse pointer over the circles, left-click the mouse and hold the button
down. Move the mouse vertically or horizontally to re-size.

Rotatingapicture:It is possible to rotate pictures in MS PowerPoint. Once a picture has
been inserted onto a slide and you have clicked on the picture so it is "outlined," notice
the green circle above the center of the picture.

Move the mouse pointer over the green circle and left-click and hold the button down.
Nowmovethemouseeitherclockwiseorcounter-clockwiseandthepicturewillrotatein the
same direction.

Inserting aGraph or Table:

TherearetwowaystoinsertagraphortableintoaPowerPointslide.



1. The graph or table may already exist in another document or file. If this is the case,
then you can simply insert the graph or table as you would a picture. Follow the
instructions under

Inserting a Picture.

Or you could Cut and Paste a graph or chart from another document or file into your
slide presentation.

2. MS PowerPoint can create graphs or tables directly in the slide. From the Menu Bar,
select

Insert►Chart(orTable).

FortheChartoption,PowerPointwillpresentaverysimplebargraph.

You will need to go in and edit the information in the bar graph to conform to the
information you wish to represent in a chart. From the Datasheet, you can enter in the
appropriate values for the columns and re-name the entities.

TheTableoptionwillpresentyouwiththefollowingwindow:

Select the appropriate number of rows and columns you wish to have in your table.
Click "OK"to insert the table. Once the table has been inserted you will be able to put
information into the table cells.

Slide Management:

Once you have completed a slide, you can create a new slide by clicking on the New
Slide icon. Notice that your previous slides still appear on the left-side frame. You can
still access your previous slides by simply clicking on them from this location.

Once all your slideshave been completed, you can present your slides in a "slideshow."
From the Menu Bar select Slide Show► View Show. Notice that the slide takesover our
entire screen.To navigate through the slides,use thearrowkeyson yourkeyboard(←,
→ or ↑, ↓). You can also navigate through your slides by clicking on the left or right
arrows in the lowerleftcornerof yourslide.To end yourslide show, click on the square box
on the lower left side of your slide show (this is difficult to see at first because it is
designedtoblendintoyouslideshowsoitwon'tbenoticeabletoyouraudience).Select End
Show from the pop-up window.



CLOSINGMICROSOFT POWERPOINT

SavingSlideShows:

When you come to a stopping point and want to leave the computer, it is important to
save your work (even if you are printing a hard copy — saving should be a reflex). To
save your work in MS PowerPoint, it is essential to know WHAT you are trying to saveas
well as WHERE you are trying to save it.

Click►File►Save fromtheMenu Bartogetstarted.

YoucanchangethefilenamethatPowerPointhaschosenjustbytypinganewonein the File
name boxat the bottom of the windowthat appears.

MS PowerPoint will automatically save your document with the suffix “.ppt” – this is
simplyatagthatletsPowerPointknowthatyourworkisspecifictothisprogram.Youdo not have
to type it – just highlight what is there (default is “Presentation1”) and write a new file
name.

The My Documents folder on your computer’s hard drive is a good place to store your
documents. A blank CD (compact disc) or a USB Jump Drive are great portable storage
devices and can contain a LOT of data. It is important to note that every consequent
commandof SAVE will overwrite your originalfile, creating themostup-to-date version. If
you want to save any changes to your PowerPoint slides without destroying the original
one:

In the Menu Bar, click ►File ►Save As from the menu bar and give your document a
new filename (unique from the original). To bring a saved document back up on the
screen from MS PowerPoint:

Click ►File ►Open from the Menu Bar. Locate where the file is located (which
folder,that is) and clickon the filename of the document you want.

Click ►Open.

PrintingSlides:

Toprint your MS PowerPointslides:

Click►File►PrintfromtheMenuBarandaPrintwindowwillpopuponthescreen. Click ►OK

for your document to start printing.

As with all commands in MS PowerPoint, you can make changes along the way. From
the Print menu, you can alter how many copies will be made, in what order the pages
will be, and much more. Other useful tools are the Print Preview function found
alongside the Print command and the



Page Setup function.PrintPreviewwillallowyoutolookoveranexactcopyofwhat willcome
outof theprinter beforeactuallyexecutingthe printcommand.

Closing theProgram:

Whenyouarefinished,

Click►File►Exitfromthemenubar OR

ClickontheXinthetoprightcornerofthecomputerscreen.

INTERNET
Introduction:

The internet in simple terms is a network of the interlinked computer networking
worldwide, which is accessible to the general public. These interconnected computers
work by transmitting data through a special type of packet switching which is known as
the IP or the internet protocol.

Internet is such a huge network of several different interlinked networks relating to the
business, government, academic, and even smaller domestic networks, therefore
internet is known as the network of all the other networks. These networks enable the
internet to be used for various important functions which include the several means of
communications like the file transfer, the online chat and even the sharing of the
documents and web sites on the WWW, or the World Wide Web.

It is always mistaken said that the internet and theWorldWide Web are both the same
terms, or are synonymous. Actually there is a very significant difference between the
two which has to be clear to understand both the terms. The internet and World Wide
Web are both the networks yet; the internet is the network of the several different
computers which are connected through the linkage of the accessories like the copper
wires, the fiber optics and even the latest wireless connections. However, the World
WideWeb consists of the interlinked collection of the information and documents which
are taken as the resource by the general public. These are then linked by the website
URLs and the hyperlinks. Therefore World Wide Web is one of the services offered by
thewholecomplicatedandhugenetworkoftheinternet.TheuseofIPintheInternetis the
integral part of the network, as they provide the services of the internet, through
different layersorganizationthrough theIP datapackets.Thereareotherprotocolsthat are
the sub-classes of the IP itself, like the TCP, and the HTTP.



Bytheturnofthecentury,information,includingaccesstotheInternet,willbethebasis
forpersonal,economic,andpoliticaladvancement.ThepopularnamefortheInternetis the
informationsuperhighway.Whetheryou want tofind the latestfinancialnews,
browsethroughlibrarycatalogs,exchangeinformationwithcolleagues,orjoininalively
politicaldebate,theInternetisthetoolthatwilltakeyoubeyond telephones,faxes,and
isolatedcomputerstoaburgeoning networkedinformationfrontier.TheInternet
supplements the traditional tools you use to gather information, Data Graphics, News
and correspond with other people. Usedskillfully, the Internetshrinks the world and
brings information, expertise, and knowledge on nearly every subject imaginable
straight to your computer.

What istheInternet?

The Internet links are computernetworks all over the world so thatusers can share
resources and communicate with each other. Some computers have direct access to all
the facilities on the Internet such as the universities. And other computers, example
privately-owned ones, have indirect links through a commercial service provider, who
offerssomeoralloftheInternetfacilities.InordertobeconnectedtoInternet,youmust go
through service suppliers. Many options are offered with monthly rates. Depending on
the option chosen, access time may vary. The Internet is what we call a Meta
network,thatis,anetworkof networksthatspanstheglobe.It'simpossibletogivean
exactcountofthenumberofnetworksorusersthatcomprisetheInternet,butitiseasily in the
thousands and millions respectively. The Internet employs a set of standardized
protocols which allow for the sharing of resources among different kinds of computers
thatcommunicatewitheachotheronthenetwork.Thesestandards,sometimesreferred to
astheInternetProtocolSuite, arethe rulesthatdevelopersadheretowhen
creatingnewfunctionsfortheInternet.TheInternetisalsowhatwecalladistributed
system;therearenocentralarchives.Technically,noonerunstheInternet.Rather,the
Internetismadeupofthousandsofsmallernetworks.TheInternetthrivesanddevelops as its
manyusersfind newways to create, displayand retrieve the information that constitutes
the Internet.

Who Ownsthe Internet?
No one actually owns the Internet, and no single person or organization controls the
Internet in itsentirety. The Internet is more of a concept than an actual tangible entity,
and itrelies on a physical infrastructure that connects networks to other networks.

Is WebandInternetthe Same?
The Internet is not synonymous with World Wide Web. The Internet is a massive
network of networks, a networking infrastructure. It connects millions of computers
together globally, forming a network in which any computer can communicate with any
other computer as long as they are both connected to the Internet. The World Wide
Web,orsimplyWeb,isawayofaccessinginformationoverthemediumoftheInternet.
Itisaninformation-sharingmodelthatisbuiltontopoftheInternet.

WEBBROWSER:

A web browser (commonlyreferred to as a browser) is a software application for
retrieving,presenting,andtraversinginformationresourcesontheWorldWideWeb.

http://www.webopedia.com/DidYouKnow/Internet/2002/WhoOwnstheInternet.asp
http://www.webopedia.com/TERM/W/World_Wide_Web.html
https://en.wikipedia.org/wiki/Software_application
https://en.wikipedia.org/wiki/World_Wide_Web


Aninformationresourceisidentifiedbya UniformResourceIdentifier(URI/URL)and may be
a web page, image, video or other piece of content. Hyperlinks present in resources
enable users easily to navigate their browsers to related resources.

AlthoughbrowsersareprimarilyintendedtousetheWorldWideWeb,theycanalsobe used to
access information provided by web servers in private networks or files in filesystems.

Usesof Internet

Internetistodayoneofthemostimportantpartofourdailylife.Therearelarge numbersof
things thatcan be doneusingtheinternetand soit is veryimportant. You can saythat with
theprogress in the internetwe areprogressingin everysphereof life
asitnotonlymakesourtaskseasierbutalsosavesalotof time.Todayinternetisused
fordifferentpurposesdependingupontherequirement.Hereinthisveryarticlewehave
mentioned then ten best uses of the internet. Here goes the list.

1) Email:

By using internet now we can communicate in a fraction of seconds with a person who
issittingintheotherpartoftheworld.Todayforbettercommunication,wecanavailthe facilities
of Email. We can chat for hours with our loved ones. There are plenty messenger
services and email services offering this service for free. With help of such
services,ithasbecomeveryeasytoestablishakindofglobalfriendshipwhereyoucan share
your thoughts, can explore other cultures of different ethnicity.

2) Information:

Thebiggestadvantagethatinternetofferingisinformation.TheinternetandtheWorld
WideWebhasmadeiteasyforanyonetoaccessinformationanditcanbeof anytype, as the
internet isflooded with information. The internet and theWorldWideWeb has

https://en.wikipedia.org/wiki/Uniform_Resource_Identifier
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https://en.wikipedia.org/wiki/Hyperlinks
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madeiteasyforanyonetoaccessinformationanditcanbeof anytype.Anykindof information
on any topic is available on the Internet.

3) Business:

World tradehas seena bigboom with the help of the internet,as ithas becomeeasier for
buyers and sellers to communicate and also to advertise their sites. Now a day's most
of the people are using online classified sites to buy or sell or advertising their products
or services. Classified sites save a lot of money and time so this is chosen as
mediumbymostofpeopletoadvertisetheirproducts.Wehavemanyclassifiedsiteson the web
like craigslist, Adsglobe.com, Kijiji etc.

4) Social Networking:

Todaysocialnetworkingsiteshavebecomeanimportantpartoftheonlinecommunity. Almost
all users are members use it for personal and business purposes. It's an awesome place
to network with manyentrepreneurs who come here to begin building their own
personal and business brand.

5) Shopping:

In today's busy life most of us are interested to shop online. Nowa day's almost
anythingcanbeboughtwiththeuseoftheinternet.IncountrieslikeUSmostof consumers
prefer to shop from home. We have many shopping sites on internet like amazon.com,
Dealsglobe.com etc. People also use the internet to auction goods. There are many
auction sites online, where anything can be sold.

6) Entertainment:

Oninternetwecanfindallformsofentertainmentfromwatchingfilmstoplayinggames online.
Almost anyone can find the right kindof entertainmentfor themselves.When people surf
theWeb, there are numerous things that can be found. Music, hobbies, news and more
can be found and shared on the Internet. There are numerous games
thatmaybedownloadedfrom theInternetforfree.

7) E-Commerce:

Ecommerce is the conceptusedfor anytype of commercial maneuvering, or business
deals thatinvolves thetransferof informationacross the globe via internet.Ithas
becomea phenomenon associatedwith anykind of shopping, almost anything. Ithas
got a real amazing and range of products from household needs, technology to
entertainment.

8) Services:

Many services are now provided on the internet such as online banking, job seeking,
purchasing tickets for your favorite movies, and guidance services on array of topics in
theeveryaspectof life,andhotelreservationsandbillspaying.Oftentheseservicesare not
available off-line and can cost you more.



9) Job Search:

Internetmakeslifeeasyforbothemployersandjobseekersasthereareplentyofjob sites
which connect employers and job seekers.

10) Dating/Personals:

People are connectingwith others though internet and finding their life partners.
Internetnotonlyhelpstofindtherightpersonbutalsotocontinuetherelationship.

E-mailing

Shortfor electronicmail, e-mailor emailis text messagesthatmay contain files, images,
or other attachments sent through a network to a specified individual or group of
individuals. The first e-mail was sent by Ray Tomlinson in 1971. By 1996, more
electronic mail was being sent than postal mail.

“Email,e-mailorelectronicmailisthetransmissionofmessages(emailsoremail
messages) over electronic networks like the internet.”

Email, sometimes written as e-mail, is simply the shortened form of “electronic mail,” a
system for receiving, sending, and storing electronic messages. It has gained nearly
universal popularity around the world with the spread of the Internet. In many cases,
emailhasbecomethepreferredmethodforbothpersonaland businesscommunication.

HowItIsUsed

Messages sent by electronic mail normally reach a recipient’s account within seconds.
They frequently include more than just text; images and numerous types of formatted
documents are now easily included as attached files. Moreover, it is no longernecessary
to be sitting in front of a PC to send or receive an email. A variety of mobile devices,
such as tablet computers and smart phones, make it possible manage correspondence
on the go.

Most e-mail systems include a rudimentary text editor for composing messages, but
many allow you to edit your messages using any editor you want. You then send the
message to the recipient by specifying the recipient's address. You can also send the
same message to several users at once. This is called broadcasting.

Sent messages are stored in electronic mailboxes until the recipient fetches them. To
see if you have any mail, you may have to check your electronic mailbox periodically,
although many systems alert you when mail is received. After reading your mail, you
can store it in a text file, forward it to otherusers, ordelete it. Copies of memos can be
printed out on a printer if you want a paper copy. E-mail can be distributed to lists of
people as well as to individuals. Ashared distribution listcanbe managed by usingane-
mailreflector.Somemailinglistsallowyoutosubscribebysendingarequestto
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themailinglistadministrator.Amailinglistthatisadministeredautomaticallyiscalled a list
server.

Togetagraspofwhatemailisit'sbest—theterminologyindicatesit—tothinkin equivalents of
"traditional" postal mail.

 The email message - Instead of using a pen to write a letter on paper, you're
using your keyboard to type an email message in an email program on yourcomputer.

 Sending the email - When the email is finished and has been addressed to the
recipient's emailaddress,youdon'tputastamponitandpostitbutpress the Send button in
the email program. This makes the email message go on its journey.

 Emailtransport- Like postal services transport lettersandparcel,
emailserverstransmit email messages from sender to recipient. Usually, emails are not
delivered to the recipient directly, though, but waiting at the "nearest" mail server to
be picked up by them.

 Fetching new mail -Ifyou'vegotnewmailinyourmailbox,yougoandfetchit. Similarly,
your email program can check for new email messages at your mail server and
download them for you to read.

http://email.about.com/od/emailclients/
http://email.about.com/library/glossary/bldef_email_server.htm
http://email.about.com/library/glossary/bldef_email_server.htm
http://email.about.com/library/glossary/bldef_email_server.htm


HTML
HyperTextMarkupLanguage(HTML)isthemainmarkuplanguageforcreatingweb pages
and other information that can be displayed in a web browser.

HTML is written in the form of HTML elements consisting of tags enclosed in angle
brackets(like<html>),withinthewebpagecontent.HTMLtagsmostcommonlycomein
pairslike<h1>and</h1>,althoughsometags,knownasemptyelements,areunpaired,
forexample<img>.Thefirsttaginapairisthestarttag, andthesecondtagistheend tag (they
are also called opening tags and closing tags). In between these tags web designers
can add text, tags, comments and other types of text-based content.

The purpose of a web browser is to read HTML documents and compose them into
visible or audible webpages.The browser does not displaythe HTML tags, butuses the
tags to interpret the content of the page.

HTML elements form the building blocks of all websites. HTML allows images and
objects to be embedded and can be used to create interactive forms. It provides a
meanstocreatestructureddocumentsbydenotingstructuralsemanticsfortextsuchas
headings, paragraphs, lists, links, quotes and other items. It can embed scripts written
in languages such as JavaScript which affect the behavior of HTML webpages.

Web browsers can also refer to Cascading Style Sheets (CSS) to define
theappearance and layout of text and other material. TheW3C, maintainer of both the
HTML and the CSS standards, encourages the use of CSS over explicit presentational
HTML markup.

Markup

HTML markupconsistsofseveralkeycomponents,includingelements(and
theirattributes),character-baseddatatypes,characterreferencesandentityreferences.
Anotherimportantcomponentisthedocumenttypedeclaration,which triggers
standards mode rendering.

The following is an example of the classic Hello world program, a common test
employedforcomparingprogramminglanguages,scriptinglanguagesandmarkup
languages. This example is made using 9 lines of code:

<!DOCTYPEhtml>
<html>
<head>
<title>HTML</title>
</head>
<body>
<p>Helloworld!</p>
</body>
</html>



(Thetextbetween<html>and</html>describesthewebpage,andthetextbetween
<body>and</body>isthevisiblepagecontent.Themarkuptext'<title>Hello HTML</title>'
defines the browser page title.)

ThisDocumentTypeDeclarationisforHTML5.Ifthe <!DOCTYPEhtml>declarationisnot included,
various browsers will revert to "quirks mode" for rendering.

Elements

HTML documents arecomposed entirelyof HTMLelementsthat, intheirmost general
formhavethreecomponents:apairoftags,a"starttag"and"endtag";
someattributeswithinthestarttag;andfinally,anytextualand
graphical content between the start and end tags, perhaps including other nested
elements.TheHTMLelementiseverythingbetweenandincludingthestartandend tags.
Each tag is enclosed in angle brackets.

The generalformof anHTMLelementistherefore:
<tagattribute1="value1"attribute2="value2">content</tag>.SomeHTMLelementsaredefinedasem
ptyelementsand
taketheform<tagattribute1="value1"attribute2="value2">.Emptyelementsmayencloseno
content,forinstance,theBRtagortheinlineIMGtag.ThenameofanHTMLelementis the name
used in the tags. Note that the end tag's name is preceded by a slash
character,"/",andthatinemptyelementstheendtagisneitherrequirednorallowed.If attributes
are not mentioned, default values are used in each case.

Element examples
HeaderoftheHTMLdocument:<head>...</head>.Usuallythetitleshouldbeincluded in the
head, for example:

<head>
<title>TheTitle</title>
</head>

Headings:HTMLheadingsaredefinedwiththe<h1>to<h6>tags:

<h1>Heading1</h1>
<h2>Heading2</h2>
<h3>Heading3</h3>
<h4>Heading4</h4>
<h5>Heading5</h5>
<h6>Heading6</h6>Paragr

aphs:

<p>Paragraph1</p><p>Paragraph2</p>

Linebreaks:<br/>.Thedifferencebetween<br/>and<p>isthat'br'breaksaline
withoutalteringthesemanticstructureofthepage,whereas'p'sectionsthepageinto



paragraphs.Notealsothat'br'isanemptyelementinthat,whileitmayhaveattributes, it can
take no contentand it may not have an end tag.

<p>This<br/>isaparagraph<br/>with<br/>linebreaks</p>Comments:

<!--Thisisacomment-->

Commentscanhelpintheunderstandingofthemarkupanddonotdisplayinthe webpage.

ThereareseveraltypesofmarkupelementsusedinHTML:

Structuralmarkupdescribesthepurposeoftext
Forexample,<h2>Golf</h2>establishes"Golf"asasecond-levelheading.Structural
markup doesnotdenote anyspecificrendering, butmost webbrowsershave default
styles for element formatting. Content may be further styled using Cascading
StyleSheets (CSS).
Presentationalmarkupdescribestheappearance of the text, regardlessof itspurpose
Forexample <b>boldface</b> indicatesthatvisualoutputdevicesshouldrender
"boldface"inboldtext,butgiveslittleindicationwhatdevicesthatareunabletodothis (such as
aural devices that read the text aloud) should do. In the case of
both<b>bold</b>and<i>italic</i>,thereareotherelementsthatmayhaveequivalent visual
renderings but which are more semantic in nature, such as
<strong>strongtext</strong>and<em>emphasizedtext</em>respectively.Itiseasierto
seehowan auraluseragent should interpret the lattertwo elements.
However,theyarenot equivalent to their presentational counterparts: it would be
undesirable for a screen- reader to emphasize the name of a book, for instance, but
on a screen such a name would be italicized. Most presentational markup elements
have
becomedeprecatedunderthe HTML 4.0 specification infavorofusingCSS forstyling.

Tables

Tablesareusedwhenyouneedtoshow"tabulardata"i.e.informationthatislogically
presented in rows and columns.

Isit difficult?

BuildingtablesinHTMLmayatfirstseemcomplicated but
if you keep cool and watch your step, it is actually
strictly logical - just like everything else in HTML.

https://en.wikipedia.org/wiki/HTML_element
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Example1:

<table>

<tr>

</table>

</tr>
<tr>

</tr>

<td>Cell1</td>
<td>Cell2</td>

<td>Cell3</td>
<td>Cell4</td>

What's thedifferencebetween <tr>and <td>?

Asyouwillseefrom theaboveexample,thisisprobablythemostcomplicatedHTML
examplewehavegivenyousofar.Let'sbreakitdownandexplainthedifferenttags:

3differentelementsareusedtoinserttables:

 Theopeningtag<table>andtheclosingtag</table>startsandendsthetable.
Logical.

 <tr>standsfor"tablerow"andstartsandendshorizontalrows.Stilllogical.
 <td>isshortfor"tabledata".Thistagstartsandendseachcellintherowsof your

table. All simple and logical.

HereiswhathappensinExample1:thetablestartswitha <table>,followedbya<tr>,
whichindicatesthebeginningofanewrow.Twocellsareinsertedinthisrow: <td>Cell
1</td>and<td>Cell2</td>.Therowishereafterclosedwitha</tr>andanewrow<tr>beginsimme
diatelyafter.Thenewrowalsocontainstwocells.Thetableisclosedwith
</table>.

Justtomakeitclear:rowsarehorizontallinesofcellsandcolumnsareverticallinesof cells:

Intheaboveexample,thetablehastworowsandtwocolumns.However,atablecan have an
unlimited number of rows and columns.



Example2:

<table>
<tr>

</tr>
<tr>

</tr>
<tr>

</tr>
</table>

<td>Cell1</td>
<td>Cell2</td>
<td>Cell3</td>
<td>Cell4</td>

<td>Cell5</td>
<td>Cell 6</td>
<td>Cell7</td>
<td>Cell8</td>

<td>Cell9</td>
<td>Cell10</td>
<td>Cell11</td>
<td>Cell12</td>

Arethereanyattributes?

Ofcoursethereareattributes.Forexample,theborderattributeisusedtospecifythe thickness
of the border around your table:

Example3:

<tableborder="1">
<tr>

</tr>
<tr>

</tr>
</table>

<td>Cell1</td>
<td>Cell2</td>

<td>Cell3</td>
<td>Cell4</td>

As with images, yo2 €nalsosetthewidthofatableinpixels-oralternativelyin
percentage of the screen:



Moreattributes?

Therearelotsofattributesfortables.Herearetwomore:

 align:specifiesthehorizontalalignmentofthecontentintheentiretable,inarow or in a
single cell. For example, left, center orright.

 valign:specifiestheverticalalignmentofthecontentinacell.Forexample,top, middle
or bottom.

Links

Inthislesson,youwilllearnhowtomakelinksbetweenpages. What do I

need to make a link?

Tomake links,you usewhat you alwaysusewhen codingHTML: an element.A simple
elementwithoneattributeandyouwillbeabletolinktoanythingandeverything.Here is an
example of what a link to HTML.net could look like:

Example 1:

<ahref="http://www.html.net/">HereisalinktoHTML.net</a>

Theelementastandsfor"anchor".Andtheattribute hrefisshortfor"hypertext
reference",whichspecifieswherethelinkleadsto-typicallyanaddressontheinternet or a file
name.

Intheaboveexampletheattributehrefhasthevalue"http://www.html.net",whichisthe full
address of HTML.net and is called a URL (Uniform Resource Locator). Note that
"http://" mustalways be included in URLs. The sentence "Here is a link to HTML.net" is
thetextthatisshowninthebrowserasthelink.Remembertoclosetheelementwithan
</a>.

Whataboutlinksbetweenmyownpages?

Ifyouwanttomakealinkbetweenpagesonthesamewebsite,youdonotneedtospell out the
entire address (URL) for the document. For example, if you have made two pages (let
us call them page1.htm and page2.htm) and saved them in the same folder
youcanmakealinkfromonepagetotheotherbyonlytypingthenameofthefileinthe link. Under
such circumstancesa linkfrom page1.htm to page2.htm could look like this:

http://www.html.net/
http://www.html.net/


Example2:

<ahref="page2.htm">Clickheretogotopage2</a>

Ifpage2wereplacedinasubfolder(named"subfolder"),thelinkcouldlooklikethis:

Example3:

<a href="subfolder/page2.htm">Clickheretogoto page 2</a>

Theotherwayaround,alinkfrompage2(inthesubfolder)topage1wouldlooklikethis:

Example4:

<a href="../page1.htm">Alinkto page 1</a>

"../"pointstothefolderonelevelupfrompositionofthefilefromwhichthelinkismade.
Followingthesamesystem,youcanalsopointtwo(ormore)foldersupbywriting"../../".

Didyouunderstandthesystem?Alternatively,youcanalwaystypethecomplete address for
the file (URL).

Whataboutinternallinkswithinapage?

Youcanalsocreateinternallinkswithinapage -forexampleatableof contentsatthe
topwithlinkstoeachchapterbelow.Allyouneedtouseisaveryusefulattributecalled id
(identification) and the symbol"#".

Usetheidattributetomarktheelementtowhichyouwanttolink.Forexample:

<h1id="heading1">heading1</h1>

Youcannowcreatealinktothatelementbyusing"#"inthelinkattribute.The"#"must
befollowedbythe idofthetagyouwanttolinkto.Forexample:

<ahref="#heading1">Linkto heading 1</a>

Allwillbecomeclearwithanexample:



Example5:

<html>

<head>
</head>

<body>

<p><ahref="#heading1">Linktoheading1</a></p>
<p><ahref="#heading2">Linktoheading2</a></p>

<h1id="heading1">heading1</h1>
<p>Texttexttexttext</p>

<h1id="heading2">heading2</h1>
<p>Texttexttexttext</p>

</body>

</html>

Hypertextmarkupmakespartsofadocumentintolinkstootherdocuments
Ananchorelementcreatesahyperlinkinthedocumentanditshrefattributesetsthe link's
target URL. For example the HTML
markup,<a href="http://www.google.com/">Wikipedia</a>, will render the word
"Wikipedia"asahyperlink.Torenderanimageasahyperlink,an'img'elementis
insertedascontentintothe'a'element.Like'br','img'isanemptyelementwith
attributesbutnocontentorclosingtag.<ahref="http://example.org"><imgsrc="image.gif"
alt="descriptivetext"width="50"height="50"border="0"></a>.

As of version 4.0, HTML defines a set of 252 character entity references and a set of
1,114,050numericcharacterreferences,bothofwhichallowindividualcharacterstobe written
via simplemarkup, ratherthan literally. A literalcharacterandits markup counterpart are
considered equivalent and are rendered identically.

The abilityto "escape" characters in this wayallows for the characters <and &(when
writtenas&lt;and&amp;,respectively)tobeinterpretedascharacterdata,ratherthan markup.
Forexample,a literal <normallyindicatesthe startof atag,and &normally
indicatesthestartofacharacterentityreferenceornumericcharacterreference;writing
itas&amp;or&#x26;or&#38;allows&tobeincludedinthecontentofanelementorin
thevalueofanattribute.Thedouble-quotecharacter("),whennotusedtoquotean
attributevalue,mustalsobeescapedas&quote;or&#x22;or&#34;whenitappearswithin

http://www.google.com/
http://example.org/
https://en.wikipedia.org/wiki/Character_entity_reference
https://en.wikipedia.org/wiki/Numeric_character_reference


theattributevalueitself.Equivalently,thesingle-quotecharacter('),whennotusedto
quoteanattributevalue,mustalsobeescapedas&#x27;or&#39;(notas&apos;exceptin XHTML
documents) when itappears within the attribute value itself. If document authors
overlook the need to escape such characters, some browsers can be very
forgivingandtrytousecontexttoguesstheirintent.Theresultisstillinvalidmarkup, which
makes the document less accessible to other browsers and to other user
agentsthatmaytrytoparsethedocumentforsearchandindexingpurposesfor example.

Data types

HTML defines several data types for element content, such as script data
andstylesheetdata,andaplethoraoftypesforattributevalues,includingIDs,names,URIs,
numbers, units of length, languages, media descriptors, colors, character encodings,
datesandtimes,andsoon.Allofthesedatatypesarespecializationsof characterdata.

https://en.wikipedia.org/wiki/User_agent
https://en.wikipedia.org/wiki/User_agent
https://en.wikipedia.org/wiki/Web_crawler
https://en.wikipedia.org/wiki/Data_type


LANGUAGEC

WhyweuseLanguage?

Weuselanguageduetofollowingreasons:
 Itstoresdata
 Howtointeractbetweeninputandoutput
 Theoperatorusestotransformandcombinedata.

WhatisC?

By 1960 languages come into existence. COBOL was being used for commercial
purposes, FORTRAN for Engineering and Scientific applications. An International
committee was setup to develop languages. This committee came out with a language
called ALGOL60. ALGOL-60 never really became popular because it seemed tooabstract,
too general. To reduce the abstractness and generality a new language called
Combined Programming Language (CPL) was developed at Cambridge University. CPL
was an attempttobringALGOL60newversion,but CPL turnedouttobesobig,having so many
features, that it was hard to learn and difficult to implement. BCPL (Basic Combined
Programming Language) developed by Martin Richards at Cambridge University aimed
to solve this problem by bringing CPL down to its basic good features.
Butunfortunatelyitturnedtobelesspowerfulandtoospecific.DennisRitchieinheritthe features
of CPL and BCPL and made a language named C. C forms the basis for many advanced,
highly powerful and effective programming languages. C is a programming language
developed at AT&T’s Bell Laboratories of USA in 1972. It was designed and written by a
man named Dennis Ritchie. In the late seventies C began to replace the more familiar
languages ofthat timelike PL/I,ALGOL etc.No one pushes C. C seems so popular,
because it is reliable, simple and easy to use. The concept of C derives its origin from a
primitive form of C which was called Basic Combined Programming Language(BCPL)
developedby Ken ThompsonofBell Laboratorieswhichhereferred to as ‘B’ . By now it
might not be difficult to guess that a name as cryptic as C was conferred to it because it
was considered to be a modified more adaptive successor of “B”. C’s compactness and
coherence is mainly due to the fact that it’s a one man language.

CBasics

Before we embark on a brief tour of C's basic syntax and structure we offer a brief
history of C and consider the characteristics of the C language.



Featuresof C

In the remainderof theChapter we will look at the basic aspectsof C programs suchas C
program structure, the declaration of variables, data types and operators. We will
assume knowledge of a high level language, such as PASCAL.

ItisourintentiontoprovideaquickguidethroughsimilarCprinciplestomosthighlevel languages.
Herethesyntaxmaybe slightlydifferentbutthe conceptsexactlythe same.

Cdoes haveafewsurprises:

 Many High level languages, like PASCAL, are highly disciplined and
structured.
 However beware -- C is much more flexible and free-wheeling. This
freedom gives C much more power that experienced users can employ. The
above example below (mystery.c) illustrates how bad things could reallyget.

CharacteristicsofC

WebrieflylistsomeofC'scharacteristicsthatdefinethelanguageandalsohaveleadto its
popularity as a programming language. Naturally we will be studying many of these
aspects throughout the course.

 Smallsize
 Extensiveuseoffunctioncalls
 Loosetyping--unlikePASCAL
 Structuredlanguage
 Lowlevel(Bitwise)programmingreadilyavailable
 Pointerimplementation-extensiveuseofpointersformemory,array,
structures and functions.

C has nowbecome awidelyusedprofessional languageforvarious reasons.

 Ithashigh-levelconstructs.
 Itcanhandlelow-levelactivities.
 Itproducesefficientprograms.
 Itcanbecompiledonavarietyofcomputers.



LowLevelLanguageSupport ProgramPortability

PowerfulandFeatureRich BitManipulation

HighLevelFeatures ModularProgramming

EfficientUseof Pointers

FeaturesofCProgrammingLanguage:

C Programming is widely used in Computer Technology; We can say that C
Programming is inspiration for development of other languages. We can use C
Programming for different purposes. Below is some of the Features of C Programming
language -

1. LowLevel Features:

1. C Programming provides low level features that are generally provided by the
Lower level languages. C is Closely Related to Lower level Language such as
“Assembly Language“.

2. Itiseasierto writeassemblylanguagecodesinCprogramming.

2. Portability:

1. C Programs are portable i.e. they can be run on any Compiler with Little or no
Modification

2. Compiler and Preprocessor make it Possible for C Program to run it on Different
PC

3. Powerful

1. ProvidesWideverityof ‘DataTypes‘
2. ProvidesWideverityof‘Functions’

3. ProvidesusefulControl&LoopControlStatements

http://www.c4learn.com/what-is-low-level-language.html
http://www.c4learn.com/c-programs/mixing-inline-assembly-program-in-c.html


4. Bit Manipulation

1. C Programs can be manipulated using bits. We can perform different operations
at bit level. We can manage memory representation at bitlevel.

2. It provides wide verity of bit manipulation Operators. We have bitwise operators
to manage Data at bit level.

5. HighLevel Features:

1. It is more User friendly as compare to previous languages. Previous languages
such as BCPL, Pascal and other programming languages never provide such great
features to manage data.

2. Previous languages have their pros and cons but C Programming collected all
useful features of previous languages thus C become more effective language.

6. Modular Programming

1. Modular programming is a software design technique that increases the extent
to which software is composed of separate parts, called modules

2. C Program Consist of Different Modules that are integrated together to form
complete program

7. EfficientUse of Pointers

1. Pointershavedirectaccessto memory.

2. CSupportsefficientuseofpointer.

C Program Structure

ACprogrambasicallyhasthefollowingform:

 PreprocessorCommands
 Type definitions
 Functionprototypes--declarefunctiontypesand variablespassedto
function.
 Variables
 Functions

Wemusthaveamain()function.



Afunctionhastheform:

typefunction_name(parameters)
{

localvariables

CStatements

}

IfthetypedefinitionisomittedC assumes that function returns an integer type. NOTE:
This can be a source of problems in a program.

SoreturningtoourfirstCprogram:

/*Sampleprogram*/

NOTE:

main()
{

printf(``IlikeCn''); exit
(0 );

}

 Crequiresasemicolonattheendof everystatement.
 printfisastandardCfunction--calledfrommain.
 nsignifiesnewline.Formattedoutput--morelater.
 exit()isalsoastandardfunctionthatcausestheprogramtoterminate.Strictlyspeakingit isnot
needed here asit isthelastline of main() andtheprogram willterminateanyway.

Letuslookatanotherprintingstatement:
printf(``.n.1n..2n...3n'');

Theoutputofthiswouldbe:

.
.1
..2
...3



C Keywords

Keywords are the set of predefined words whose functionality has been expressed to
thecompilerandwhenevercalledupontheyfurnishtheirtaskwithutmostcomfort.The
keywords cannot be used for anyfunction other than what it is defined for, not even as
variable names. This code of conduct it will result in giving a new meaning to the
keyword, which is not permissible by the computer. There are 32 keywords in C which
are used at various points in a program to launch the proficiency of thelanguage.

C Instructions

Thedifferenttypesofconstants,variablesandkeywordsthenextlogicalstep istolearn how to
learn they are combined toform instructions.There arefour types of instruction in C:

 TypeDeclarationInstruction
 Input/OutputInstruction
 ArithmeticInstruction
 ControlInstruction

Type Declaration Instruction: We can declarethe type of variablesusedin CProgram by
using this instruction. Any variable used in a program must be declared before using it
anystatement.The type declaration statementusuallywritten at the beginning of the C
program.

intEmpCode;
float Bsalary;
charEmpName

Input/OutputInstruction:Wecanperformthefunctionofsupplyinginputdatatoa program
and obtaining the output results from it.
Arithmetic Instruction: We canperformarithmeticoperationsbetweenconstantsand
variables.
Control Instruction: Wecancontrolthesequenceofexecutionofvariousstatements in a C
program.

Variables

Aprogramismadeofdataandinstructionstomanipulatethosedata.Notethatdata have to be
stored somewhere, and thus will need some memory space in the RAM.

Avariableisanentitythatisusedtostoredata.Withoutvariables,thereisnoway(or actually
NO PLACE) to store data. A variable has

 aname(morespecificallya symbolicname)



 anassociatedphysicalmemoryspace(portioninaRAM)
 adatatype
 avalue(dependsondatatype)
 ascope
 a lifetime

Howdoyoudeclareavariable?

InC,thesyntaxfordeclaringavariableisasfollows:

<variablename>

The symbol<item>meansthatit isrequiredto specifythe itemenclosed within apairof
angled brackets. A semicolon signifiesthe end ofa declaration. A missing semicolonwill
cause the compiler to generate a syntax error. Variables should be named following the
C naming conventions.

Example:

charch;

int i;

float f;

doubled;

It is possible to declare several variables of the same type on the same line. In such
a case, a comma should be inserted between two variables. A missing comma will
generate a syntax error.

Example:

charch1,ch2;

Int x, y, z;

float hourly_rate, number_of_hours, salary;

double numerator, denominator;

BasicDataTypes
The language of C supports several types of Data, each of which is represented in a
variedmannerwithinthememory.Thedatainthememorycanbeof integertypeorof character
type or of integer with decimal points. Whenever an integer or a character is used in a
program the computer should be able to identify where to store it in the memory.



The basic data types are depicted in a tabular format to get a better understanding of
the basics of C programming.

DataType Description Memory
Requirement

Range Format
Specifier

Int wholenumbers 2bytes -32768to %d,%i
long -- 4bytes +32767 %ld

Char Characters 1Byte 0to255 %c,%s

Float Numberswith
Decimals

4Bytes 1.0E-37to
1.0E+37

%f

Double Numberswith 8Bytes 1.7E-308to %lf

Int: The particular data type deals in storing only whole integer numbers and they are
incapableofdealingwithfractionsornumberwithdecimals.Thenumberwhichtheycan deal
with a range from -32768 to +32767. An int requires 2 bytes of memory by most
computers.

Char: The chardata type holds individualcharactersoralphabetsand theyrequire only 1
byte of memory. Most compilers permits a range of 0 to 255 regarding the char data
type.

Float: Afloatdatatypeisinvolvedinrestoringfloatingpointnumbersortoputitsimply, it is used
to store numbers with decimalpoint. The float desires 4 bytes for storage and has a
fractional precision of 6 digits.

Double: A double data type is also used for the restoration of floating point numbers.
The difference lies in the precision and storage space. Double offers a great precision,of
about 15 digits and compiler requires 8 bytes to store a double. The ranges with in
which the float can be represented are 1.7 E - 308 to 1.7 E + 308resp.

QualifiersUsedWithBasic Data Types

To expand the horizon of the basic data types, making itmoreflexible and adaptable to
get into various situations with preciseness and accuracy. The qualifier tagged to the
data types are LONG, SHORT, SIGNED AND UNSIGNED. To make any data type a
qualifier,thenameof the qualifierhasto be tagged before the datatype.

Long: As the name suggests the qualifier long extended the range of the data type to
which it is prefixed. It can be applied to only the int and double data types and it
expandsthespectrumofrangefromamaximumof2,147,483,647to -2.147,483,647.A



long int requires memory that is more than an ordinary int and therefore takes 4 bytes
forstorage.Tomakean integeralongqualifier just addsthe wordlongbeforeit.

Short:This qualifier is most interesting because if an ordinary int has the samememory
value as that of long i.e. 4 bytes a short will have 2 bytes, but if an int has memory of 2
bytes a short will have the same memory i.e. 2Bytes.

Signed: By using signed data qualifier that data type can accommodate both positive
and negative numbers. When a variable is signed it has the same positive andnegatives
range as a regular int. By default an int is a signed datatype.

Unsigned: The qualifier unsigned is tagged mostly to int and it also has the same
memory requirement as that of ordinary int i.e. 2 bytes. Unsigned integer has a range
from 0 to 65535.

Constants

ANSI C allows you to declare constants. When you declare a constant it is a bit like a
variable declaration except the value cannot be changed.

Theconstkeywordistodeclareaconstant,asshownbelow:

intconsta=1;
constinta=2;

Note:

 Youcandeclaretheconstbeforeorafterthetype.Chooseoneanstick to it.
 Itisusualtoinitializeaconstwithavalueasitcannotgetavalueany other

way.

The preprocessor #define is another more flexible (see Preprocessor Chapters) method
to define constants in a program. You frequently see const declaration in function
parameters. This says simply that the function is not going to change the value of the
parameter. The following function definition used concepts we have not met (see
chapters on functions, strings, pointers, and standard libraries) but for completeness of
this section it is included here:

voidstrcpy(char*buffer,charconst*string)

ThesecondargumentstringisaCstringthatwillnotbealteredbythestringcopying standard
library function.



Operators inC:

Operators can briefly be defined as the tools used for solving various mathematical,
conditional, relational and logical problems. The operators that you will be dealing with
are arithmetic operators, unary operators, relational and logical operators. The items in
between which the operators are placed are called operands.

Arithmeticoperators:
Arithmetic Operators can be considered the main point of all the operators. Arithmetic
operators are tools that help us in computing various mathematical operations.

Operators Function Performed
+ Addition

- Subtraction
* Multiplication

/ Division
% (Modulus)Findsthe remainder

UnaryOperators:
Therearetwotypesofunaryoperators:-

 Theincrementoperator(denotesas‘++’)
 Thedecrementoperator(denotesas‘--’ )

When the increment operator is prefixed to a variable which holds an integer it
increases the value of the number by one. Similarly the decrement operator decreases
the value by one.

RelationalandLogical Operators:

Operators Significance

< Lessthan
<= Less thanorequalto

> Greaterthan
>= Greaterthanorequalto

EqualityOperators Significance
== Equalto

!= Notequalto
LogicalOperators Significance

&& And
|| Or



! Not

Assignmentis=i.e.i=4;ch=`y';

Increment ++,Decrement --whicharemoreefficientthantheirlonghandequivalents,
forexample:--x++isfasterthanx=x+1.

The++and--operatorscanbeeitherinpost-fixedorpre-fixed.Withpre-fixedthevalue is
computed before the expression is evaluated whereas with post-fixed the value is
computed after the expression is evaluated.

Intheexamplebelow,++zispre-fixedandthew--ispost-fixed: int

x,y,w;
main()
{
x=((++z)-(w--))%100;
}

Thiswouldbeequivalentto:

intx,y,w;

main()

{

z++;
x=(z-w)%100;
w--;

}

The%(modulus)operatoronlyworkswithintegers.Division/isforbothintegerandfloatdivision.Sobe
careful.Theanswerto:x=3/2 is1 even if xisdeclaredafloat!!

RULE:Ifbothargumentsof/areintegerthendointegerdivision.

So make sure you do this. The correct (for division) answer to the above is x = 3.0 / 2 or x= 3 / 2.0 or

(better)x=3.0/2.0.ThereisalsoaconvenientshorthandwaytoexpresscomputationsinC.Itis very



commontohaveexpressionslike: i = i +3or x = x*(y+2) ThiscanwritteninC(generally)in a shorthand
form like this:

whichisequivalentto(butmoreefficientthan):

So we can rewrite i = i + 3 as i +=3 and x=x*(y+2)asx*=y+2.

NOTE:that x *= y+2means x =x*(y+2)and NOT x =x*y+2.

Comparison Operators

Totestforequalityis==

Awarning:Bewareof using``=''insteadof ``=='',suchaswritingaccidentally

if(i=j).....

This is a perfectly LEGAL C statement (syntactically speaking) which copies the value in
"j" into "i", and delivers this value, which will then be interpreted as TRUE if j is non-
zero. This is called assignment by value -- a key feature of C.

Notequalsis:!=

Otheroperators<(lessthan),>(graterthan),<=(lessthanorequals),>=(greaterthan or
equals) are as usual.

Pointers

C supports the use of pointers, a type of reference that records the address or location
of an object orfunctionin memory. Pointers can be dereferencingtoaccess datastored at
the address pointed to, or to invoke a pointed-to function. Pointers can be manipulated
using assignment or pointer arithmetic. The run-time representation of a pointer value
is typically a raw memory address (perhaps augmented by an offset- within-wordfield),
but sincea pointer'stype includes thetypeofthethingpointedto,

http://en.wikipedia.org/wiki/Pointer_(computer_programming)
http://en.wikipedia.org/wiki/Reference_(computer_science)
http://en.wikipedia.org/wiki/Pointer_arithmetic


expressions including pointers can be type-checked at compile time. Pointer arithmeticis
automatically scaled by the size of the pointed-to data type. Pointers are used for many
different purposes in C. Text strings are commonly manipulated using pointers into
arrays of characters. Dynamic memory allocation is performed usingpointers.

StatementsinC Language
C needs some kind of managerial system which instructs the computer what function
has to be performed at which time. The control statement act as a manager. You will
amaze at the functions the different control statements handle. For example in a
program you may have a statement in which a multiplication operation is to be
performed and in the next an addition operation and after the next line there may be a
statementwhichmaywantitselftoberepeated8timesandanotherstatement maylike itself to
be skipped and attended to at a later stage. All these conditions are managed by the
control statements.

The sequence control structure is one of the basic uncomplicated control statements.
The idea is very simple. In the sequence control instructions the statements to be
executed are done so in a serial manner one after the other. The C compiler first
executes the opening line and then moves on to the next and so on. In a serial fashion
and the entire program is executed in this manner.

ConditionalStatement
C program executes program sequentially. Sometimes, a program requires checking of
certain conditions in program execution. C provides various key condition statements to
check condition and execute statements according conditional criteria. Thesestatements
are called as 'Decision Making Statements' or 'Conditional Statements’. Followings are
the different conditional statements used in C:

1. If Statement
2. If-Else Statement
3. NestedIf-Else Statement
4. SwitchCase

If Statement: The if statement can be used to test conditions so that we can alter the
flow of a program. Code:

#include<stdio.h>
int main()

{
int mark;
charpass;

http://en.wikipedia.org/wiki/String_(computer_science)
http://en.wikipedia.org/wiki/Dynamic_memory_allocation


scanf("%d",&mark);
if (mark > 40)

pass="y";
return 0;

}

If-ElseStatement:Theifstatementfirsttestsifaconditionistrueandthenexecutesan instruction
and the else is for when the result of the condition is false. Code:

#include<stdio.h>
int main()
{

int mark;
charpass;
scanf("%d",&mark);
if (mark > 40)
{

}
else
{

}

pass = "y";
printf("Youpassed");

pass = "n";
printf("Youfailed");

return0;
}

The Switch Statement: The switch statement is just like an if statement but it has many
conditionsandthecommandsforthoseconditionsinonly1statement.Itisrunsfasterthan an if
statement. In a switch statement you first choose the variable to be tested and then you
give each of the conditions and the commands for the conditions. You can also put in a
default if none of the conditions are equal to the value of thevariable.
For Loop, While Loop, BreakandContinue
Controlstructuresarebasicallyofthreetypes–

 Sequencestatements
 Iterativestatements
 Selectionstatements



Sequence Statements: All the State in a program except the iterative & statements.
They are generally the individual statements which perform the task of input, output,
assignment declaration etc.

Iterative Statement are those repeated execution of a particular set of instructions
desired number of times. These statements are generally called loops for theirexecution
nature.

TypesofLoopingStatements:

Basically, the types of looping statements depend on the condition checking mode.
Condition checking can be made in two ways as: Before loop and after loop. So, there
are 2(two) types of looping statements.

 Entrycontrolledloop
 Exitcontrolledloop

1. Entrycontrolledloop:

Insuchtypeofloop,thetestconditionischeckedfirstbeforetheloopisexecuted.

Somecommonexamplesofthisloopingstatementsare:

 whileloop
 forloop

2. Exitcontrolledloop:

In such type of loop, the loop is executed first. Then condition is checked after blockof
statements are executed. The loop executed at least one time compulsarily.

Somecommonexampleofthisloopingstatementis:

 do-whileloop

In C language the iterative statements (loops) can be implemented in the three loops
and they are

TheForLoop

Syntax-

for(initialization;condition;incrementation)
{



bodyofloop
}

For Loop will perform its execution until the condition remains satisfied. If the body of the
loop consists of more than one statement then these statements are made compound byplacing
the open and closed curly brackets around the body of the loop. For loop is a count loop. The
initialization condition and incrementation may be done in the same statement. For loopwillnot
executeat least oncealsoiftheconditionisfalseatthefirsttimeitself.

TheWhileLoop

Syntax–
Initialization;
While(condition)

{
Body of loop;
Incrementation;

}

In this loop, initialization, condition and incrementation is done in the three different
statements.This loopsis countas wellas event loop. In case of while loops the bodyof the
loop will consist of more than one statement because each time one statement will be
of incrementation. Hence the open and closed curly brackets are required.

Do-While LoopStatement:

ThethirdloopstatementavailableinCisdo-whilestatementsyntax:- Initialization;
Do
{
Body of loop;
Incrementation;
}while(condition)

AnintroductiontoArrays

The concept of arrays depends on other data types, which was meant to facilitate the
storage of abundant amount of number and wasting an entire delivery of space in the
memory.Itwouldbelikebuyingtwodozenbooksandultimatelyusingoneanddumping the rest
in the garbage. Arrays can be defined as a collection of similar elements. An arrayof
elementscanbe formed onlyif all the elements areof one particular data type
i.e. all of them are either integer or character or a floating point number, but there
cannot exist an array which hosts an combination of these data types.



Advantageof Arrays

The usage of arrays is crucial to any professional programming. Arrays just make the
lifeofaprogrammerabiteasier.Itrelieveshim ofaburdenof having tokeepnaming
thevariables.Anarrayisasinglevariableholdingmultipledata.Eachdataisreferredto
byitselementnumber,Ifforinstance,youwishtostorealistofItemsyoucouldjust name the
variable ‘item_code’and keep storing the data by referring to item_code (1), item_code
(2),item_code (3),.........................etc.

ArrayDeclaration

Like other variables an array needs to be declared so that the compiler will know what
kindofanarrayandhowlargeanarraywewant.Inourprogramwehavedonethiswith the
statement

intsal[20];
Hereintspecifiesthetypeofthevariable,justasitdoeswithordinaryvariablesandthe word sal
specifies the name of the variable. The [20] however is new. The number 20 tells
howmanyelements of the type int will be in ourarray. Thisnumberis oftencalled
the“dimension”ofthearray.Thebracket([])tellsthecompilerthatwearedealingwith an array.

TypesofArrays

Thearrayisdividedintotwoparts:
 SingleDimensionalArrays
 MultidimensionalArrays

SingleDimensionalArrays:

Thesingledimensionalarraysasthenamesuggested,handlesonlyasingleadvance of similar
elements. That is to say you can only have one row of elements and the size of a single
dimensional array depends on the programmer. Basically the single dimensional arrays
facilitate the accommodation of many similar elements in a single variable. The
succeeding sections after which you will have a cloud less view of the single
dimensional arrays.

MultidimensionalArrays:

The multidimensional arrays are two or more arrays clubbed together. They can be of
two dimensional type or three dimensional types or more, but you can restrict the
research only to two and three dimensional arrays. An example of the two dimensional
arrays is the matrix because like the matrix the two dimensional arrays have two
matrices one symbolizing the row elements and the other the column elements. The
three dimensional array is a shade different because the first array list the number of



tables of the two dimensional arrays. The rest of the two arrays are similar to the two-
dimensionalarrayin the sense thatoneisforthe rowandthe otherisforthe column.

ArrayInitialization

The initial step of declaring of an array is done. You have given it a variable name and
also declared its size but upto this stage the array is empty. It is like a box without any
book in it. Similarly declaration of variable is done but some values have to be passed
into it. You must be aware of initializing ordinary variables but how do you initialize an
array in which more than one value has to be initialized into one array variable.

EnteringData intoan Array:

You have declared an array by giving it a specific name and size you can try andexplore
the individualities of eachelementin thearray, thatis to sayhoweach element is
addressed in an array. Array element indexing always starts with 0.
Number[0] 1stelement
Number[1] 2ndelement
Number[2] 3rdelement
Number[3] 4thelement
Thismeansthat[0]willholdthefirstvalue,[1]thesecond,[2]thethird&soonIfyou
wanttoaccessthefourthelementofthearray“sal”youhavetowritesal[3].

Cdescribestwodistinct methods:

a) StaticInitialization
b) DynamicInitialization

Static:

Thearrayonceinitializedinthiscannotbealteredbytheuser.Thismeansthateach
time the program isexecuted, the same valuesareutilized and theycan be altered only
from the code. It doesn’t require the user to input values for the array. This type of
initialization is doneatthe time of the declarationof the array. Thevalue to be inserted
are mentioned in the braces
intsal[4]={101,102,103,104,105}; int
a [ 2] = { 201,202,320 } ;
In the static initialization the number of values to be allocated in mentioned in the
square bracket and the element is mentioned in the curly braces. The elements are
initialized in a static mode.

Dynamic:

In static initialization you noticed that the elements of the array are initialized while
declaring the array, but there is problem. If you want to alter the values or if you want
theusertosupplythevaluesthenstaticinitializationwillturnouttobearawthing. That



is where dynamic initialization takes control of the reigns. The user can be allowed to
enterthevaluesofhischoiceintothearrayandwhentheprogramreturnthevaluesare not
retained and they cover the way for new values. Dynamic initialization can be done
using the For Loop
for(i=0;i<=10;i++)

{
printf(“Entervalues“);
scanf(“%d”,&sal[i]);
}

Arrayinsidethe Memory

The element stored in a serial order or they are stored randomly.
int sal [ 8 ] ;

The statement indicates that an array variable is to be created which is of an integer
data type and the array can hold 8 elements. In the memory 16 bytes will be reserved
because each integer will be 2 Bytes long. The array is initialized with some numbers,
this array will host some unrelated numbers. Once the array is initialized the elements
are stored in a continuous manner.

201202203204205206207208

31123114311631183120312231243124
The number entered by the user is registered in a successive pattern and each element
takes 2 bytes. This is exactly how it represented in the memory of a computer. The
number below the element location is the address of the location and each element has
its unique address in the memory by which it is identified.

MultiDimensional Arrays:

Multi dimensional array requires separate brackets for each subscript. One dimensional
array has a pair of square brackets, a two dimensional array will have two pairs of
square brackets, three dimensional array three pairs of square brackets and so on.

TwoDimensionalArray:

A two dimensional arraycan be visualized as an arraybelowan array. Two dimensional
arrays will have two pairs of square brackets.
Syntax:-datatypearrayname[statement1][statement2]
The two dimensional array is often referred to as a matrix. The statement one and two
are the subscripts thatthe two dimensional array willhold. One will specifythe row and
expression, two will specify the column and they indicate the number of array elements
associated with each subscript.

intA[ 4] [2 ]; Column0 Column1



RowNo0 4200 10
RowNo1 6500 20
RowNo2 7850 30
RowNo3 3450 40

ThustheelementinA[0][0]willbe1000andtheelementA[3][3]willbe40.Therestof the
numbers can be figured by having a look at the above table. In the memory the
element are placed in a sequential pattern such that the element [0][0] will be first
followedbytheelementin[0][1]followedby[1][0]andsoon.

CharacterArrays

C is also flexible that it extends it’s services to character also. It means that arrays can
be formed using even characters. One such array of characters is called string. A string
is a collection of characters that are in a particular order.
charname[10]=“Ankush” ;
In the above example name is an array with an element holding capacity of 10 and it
holds a string called “Ankush” The first element is stored in the [ 0 ] th position of the
arrayname.Thatis,thealphabetAwillstoredinthe[0]thposition,nwillbeinthe[1] st position
and so on till [ 9] th element.
A doubt may arise that while the array can accommodate 10 values only 6 have been
entered. What happens to the rest? Since only 4 values have been accommodated the
7th value will be a null character ( \0 ) which represents the end of the string. This will
placed automaticallyatthe end of the string if anyof the arrayindexes are vacant.
Ablankspacecannotexistbetweenanytwo characterswhiletakinginputfrom theuser unless
accompanied by a specific format specified.

Strings

A group of integers can be stores in an integer array. Similarly a group of characterscan
be stored in a character array. Character array are many a time also called strings. Most
languages internally treat strings as character arrays, but somehow conceal this fact
from the programmer. Character arrays or strings are used by programming languages
to manipulate text such as words and sentences. A string constant is a one dimensional
array of characters terminated by a null (‘\ 0’) forexample,

charname[]={‘I’,‘T’,’T’,’C’,‘O’,‘M’,’P’,’U’,‘T’,‘E’,‘R’,‘
\0’}
Each character in the array occupies one byte of memory and the last character is
always ‘\ 0 ’. What character is this? It looks like two characters, but it is actually only
one character, either the \ indicating that what follows it is something special. ‘\ 0 ‘is
called null character. Note that ‘\0’ and ‘0’ are not same. ASCII value of ‘ \0 ‘ is 0
whereas ASCII value of ‘ 0 ‘ is 48 It shows a way a character array is stored in



memory. The elements of character array are stored in contiguous memory locations.
The terminating null (‘\ 0 ‘ ) is important, because it is the only way the functions that
work with a string can know where the string can know where the string ends. A string
not terminated bya ‘\0‘is reallya string, but merelya collectionof characters.

WithCcompileralargesetofusefulstringhandlinglibraryfunctionsareprovided.

Function Use
strlen Findslengthofastring

strlwr Convertsastringtolowercase

strupr ConvertsaStringtoUpperCase

strcat Appendsonestringattheendofanother

strcpy Copiesa StringintoAnother

strcmp Comparestwostrings

strdup DuplicatingaString

strrev ReversingaString

strlen ( )

Thisfunctioncountsthenumberofcharacterspresentinastring. void
main ( )

{ chararray[]=”Hello“,new[20]; int
size, size1, size2 ;
printf(“EnteraString“);
scanf ( “ %s ”,new ) ;
size = strlen ( array ) ;
size1=strlen(“SoftBrainComputers“); size2
= strlen ( new ) ;

printf(“\nLengthofstring%sare%d”,array,size);
printf(“\n Lengthof Second string%sare%d”,”SoftBrain

Computers” ,size1 ) ;

printf(“\nLengthofThirdstring%sare%d“,new,size2);
getch( ) ;

}

strcpy()

Thisfunctioncopiesthecontentsofonestringintoanother.Thebaseaddressesofthe source
and target strings should be supplied to this function.



voidmain()
{
charsource[]=”SoftBrainComputers“;
chartarget[20],old[10],new[10];
printf(“EnteraString“);
scanf (“ %s ” , old ) ;
strcpy( target, source) ;
strcpy ( new ,old ) ;
printf(“\nSourceStringare%sandtargetStringare%s“,source,target);
printf(“\nSecondSourceStringare%sandSecondtargetStringare%s“,old,

new);
getch();
}

On supplying the base addresses strcpy ( ) goes on copying the characters in source
stringintotargetstringtillitdoesn’tencountertheendofsourcestring(‘ \0‘).Itisour
responsibility to see to it that the target string’s dimension is big enough to hold the
string meal, character by character.

Strcmp ( )

This is a function which compares two strings to find out whether they are same or
different.Thetwostringsarecomparedcharacterbycharacteruntilthereisamismatch or end
of one of the strings is reached, whichever occurs first. If the two strings are identical,
strcmp ( ) returns a value 0. If they are not, it returns the numeric difference between
the ASCII values of the non-matching characters.

Function

A function is a self contained block of statements that perform a coherent task of some
kind. Every C program can be thought of as a collection of these functions. Sometimes
the interaction with this person is very simple sometimes it’s complex.
You havea task whichisalways performedexactlyin the same way... saya servicingof
yourmotorbike.Whenyouwantittobedone, yougototheservicestationandsay“I’s time, do it
now You don’t need to give instructions, because the mechanic knows his job. You
don’t need to be told when the job is done. U assumes the bike would be serviced in
the usual way, the mechanic does.
AsimpleCfunctionwhichoperatedinmuchthesamewayasthe,mechanics.Wewill
belookingattwothingsaprogramthatcallsoractivatesthefunctionandthefunction itself.
voidmain()

{message();
printf(“\nThanksafterreturnoffirstfunction“); getch
( ) ;



}
message()
{
printf(“\nWelcometothefirstfunctionprogram“);
}

Note:
AnyCprogramcontainsatleastonefunction.
Ifaprogramcontainsonlyonefunction,itmustbemain().
In a C program if there are more than one functions present, then one ( and onlyone )
of these functions must be main( ), because program execution always begins with
main ( ) .
ThereisnolimitonthenumberoffunctionsthatmightbepresentedinaCprogram.
Eachfunctioninaprogramiscalledinthesequencespecifiedbythefunctioncallsin main( ).
Aftereachfunctionhasdoneitsthings,controlreturnstomain().Whenmain()runs out of
function calls, the program ends.

Functions maybedivided into threecategories.

 Without argumentswithout returnvalue
 Withargumentswithoutreturnvalue
 Withargumentswithreturnvalue

Withoutargumentswithoutreturnvalue

For functions of this type neither the caller function nor the called function take any
arguments. When a function is called the control jumps directly to the function and
executesthestatementsthatarespecifiedwithinthecalledfunction.Afterthestatement is the
called function isexecuted, the control returns to the mainprogram.

Withargumentswithoutreturnvalue

For function this the caller function transport some values to the called function or the
function definitely where these values are used for some specific function or
computation but once the computed value is found out within the called function the
value is not returned back to the caller function .

With argumentswithreturnvalue

In this type of functions the values as the arguments are being passed into the called
functions where theywill be computed and a definite result is relayed back to the caller
function and the valuewill be printed from there.

Advantageof Functions:

A programmer can identify whatever actions are performed repeatedly on various
partsoftheprogram,writethemasafunctionandcallthefunctionfromvariouspartof



the program whenever needed. This approach avoids code duplication. Instead of
duplicating the same code in different parts of the program, you just write the function
onceandcallitfromdifferentpartsoftheprogramthusreducingtheexecutablefilesize and
redundancy of code, making the maintenance of code easy.
In a multi tasking system like Unix there is a direct relationship between the amount of
memory a program consumes and the speed with which it runs You will in general find
that large programs which demand a lot of memory sluggish.
Breaking down your program into subroutines lends your program a structure. You can
divide your task into multiple sub-tasks, develop a function for each sub task, and
integratedthemintoasingleprogram.Onceafunctioniswrittenandcompletelytested,
aprogrammercanexpectittosmoothlyfitinwiththerestoftheprogrammodules.
Once afunction iswritten, tested andfound to be workingasperthe expectations, the
function can be loaded into a library, and can be used in an all together different
application. This approach encourages code reusability.

Thetypesofvariablesare:
 LocalVariables
 GlobalVariables

LocalVariables:

The fact that main is a function and you can declare any number of variables within it.
Soifaruleholdsgoodforonefunctionwhycan’titforotherfunctions?Itdefinitelycan. You can
declare a variable inside any function belonging to any size and type. Thus variables
declared inside a function are called local variables and are valid and can be used within
that function. The life of these variables exists until they are within the function. It is
same as the value of a particular variables in a program cannot exist for all the
programs. Anyattemptto breakthe rules will result anerror.

Global Variables:

Before you can accuse C of being inefficient in certain areas it pops up with an
alternative. The alternative for reducing the before mentioned problem is declaring the
variables globally. The global variables are otherwise called external variables andunlike
the local variables which are confined only to the function which has them, the global
variablescan be used anywhere in the program The global variablesare declared outside
the main i.e. before beginning the program and the values hold good throughout
theprogram.The storage for global variables is in afixed region of memory set aside for
this specific purpose by the compiler. The effectiveness of declaring globally can be felt
when many functions in a program use the samedata.
Defining a variable as global is particularly advantageous because its value is made
available to all other functions. But the only risk factor involved in this is that if any
function manipulatesoralterthe globalvariable than anyotherfunction usingthe same
variable at the same time gets the altered value.



Recursion in Functions

Recursion in general terms means repeating itself. A recursive function is a process
wherethefunctioncallsitselfrepeatedlyuntilaparticularconditionissatisfied.Itismore like the
loop conditions. But the difference lies in that each action or recursion is based in the
result of the previous one.
A recursive result triggers the recursive action for the next result until the condition is
satisfied.Foraproblemtobesolvedrecursivelytherearetwoconditionstobesatisfied. The
problem must be written in a recursive form, the recursion must have a condition which
seals the recursion.

Cprogramto checkoddor evenusingmodulusoperator

#include<stdio.h>

main()
{
intn;

Printf("Enteraninteger\n");
Scanf ("%d",&n);

if (n%2==0)
Printf("Even\n");

Else
Printf("Odd\n");

return0;
}

We can use bitwise AND (&) operator to check odd or even, as an example consider
binaryof 7 (0111)when we perform7 & 1theresultwillbe oneandyou mayobserve
thattheleastsignificantbitofeveryoddnumberis1,so(oddnumber&1)willbeone always and
also ( even number & 1 ) is zero.

Cprogramtocheckodd orevenusingbitwise operator

#include<stdio.h>

main()
{
intn;

printf("Enteraninteger\n");
scanf("%d",&n);



if (n &1 ==1 ) printf("Odd\n");
else
printf("Even\n");

return0;
}

Findodd oreven usingconditional operator

#include<stdio.h>

main()
{
intn;

printf("Inputaninteger\n");
scanf("%d",&n);

n%2==0?printf("Even\n"):printf("Odd\n");

return0;
}

Cprogramto checkodd orevenwithout usingbitwise ormodulus operator

#include<stdio.h>

main()
{
intn;

printf("Enteraninteger\n");
scanf("%d",&n);

if((n/2)*2==n)
printf("Even\n");

else
printf("Odd\n");

return0;
}

Incprogramminglanguagewhenwedividetwointegerswegetanintegerresult,For
exampletheresultof7/3willbe2.Sowecantakeadvantageofthisandmayuseitto
findwhetherthenumberisoddoreven.Consideranintegernwecanfirstdivideby2



andthenmultiplyitby2iftheresultistheoriginalnumberthenthenumberiseven
otherwisethenumberisodd.Forexample11/2=5,5*2=10(whichisnotequalto
eleven),nowconsider12/2=6and6*2=12(sameasoriginalnumber).Theseare some logic
which may help you in finding if a number is odd or not.

Primenumberprogram inclanguage

#include<stdio.h>i

nt main()
{
intn,i=3,count,c;

printf("Enterthenumberofprimenumbersrequired\n");
scanf("%d",&n);

if(n>=1)
{
printf("First%dprimenumbersare:\n",n);
printf("2\n");

}

for(count=2;count<=n;)
{
for(c=2;c<=i-1;c++)
{
if(i%c==0)
break;

}
if(c==i)
{
printf("%d\n",i);
count++;

}
i++;

}

return0;
}



Outputofprogram:

C program for primenumberor not

#include<stdio.h>

main()
{
intn,c=2;

printf("Enteranumbertocheckifitisprime\n"); scanf("%d",&n);

for(c=2;c<=n-1;c++)
{
if(n%c==0)
{
printf("%disnotprime.\n",n);

break;
}

}
if(c==n)
printf("%disprime.\n",n);

return0;
}

C program for primenumberusing function

#include<stdio.h>in

tcheck_prime(int);

main()



{
intn,result;

printf("Enteranintegertocheckwhetheritisprimeornot.\n"); scanf("%d",&n);

result=check_prime(n); if

( result == 1 )
printf("%disprime.\n",n); else
printf("%disnotprime.\n",n);

return0;
}

intcheck_prime(inta)
{
intc;

for(c=2;c<=a-1; c++)
{

if(a%c==0 )
return0;

}
if(c==a)
return1;

}

Therearemanylogictocheckprimenumbers,onegivenbelowismoreefficientthen above
method.
for(c=2;c<=(int)sqrt(n);c++)
Onlycheckingfrom2tosquarerootofnumberissufficient. There is
much more efficient logic available.
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